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12.0 Release Notes

General

ID Management

For Ls-Dyna and Nastran user profiles, a new ID management capability has been added. The toolset 
enables complete control for all ID rules and renumbering operations based on include files. The 
renumbering can occur when creating a new model or resolving issues with a legacy model. There are 
a number of advanced operations such as locking of specific ID’s, the ability to exclude certain entities 
from any renumbering operation, plus much more. There are several correction renumbering options if 
a ID overflow has occurred. There are also user definable ID rules for any newly created entity.  

Composites

•	 Laminate realization has been enhanced to support core sample validation

•	 Zone based Nastran, Abaqus and Ansys composite property creation has been added

•	 Laminate editing functions have been enhanced to support copy, insert and modify ply layup and 
import and export of ply stack data from Excel and CATIA

•	 The ply realization option has been enhanced by adding additional search methods and sample 
points for boundary recovery



•	 New ply visualization tools are introduced to separate individual plies and compare them with the 
geometry ply with the resulting elements sets

•	 Exporting ply and stack up data from HyperMesh to CATIA is added either using CPD or Fibersim

•	 Converting zone-based composite models to ply-based models is enhanced

Resolved Issues

•	 Robustness of CPD cad import and ply realization has been vastly improved

•	 Robustness of Fibersim import and ply realization has been improved

•	 Display of ply and elements associated to ply has been enhance

Connectors

Enhanced Add Link Capability in the Connector Browser

The add link functionalities in the Connector Browser include further enhancements of former add 
links capabilities. It is now possible to:

•	 Update the connector links of multiple connectors at once by preserving individual settings that 
were previously defined, such as tolerance and number of layer.

•	 Define the number of layers by the tolerance, instead of having to predefine it.

•	 Add connector links from scratch by removing any links that were previously defined, and then 
starting a search for new links to add on a cleared connector.

•	 Reject capabilities have now been added to the add link tool.

Connections of Type Hexa Adhesive can be Absorbed as Seam Connectors Now

In the Absorption dialog > Adhesive tab, a new checkbox “Absorb as seam, if possible” is now 
available. It is activated by default, and allows hexa adhesives to be absorbed as seam connectors as 



long as it has a regular pattern from exclusively hexa elements. If the hexa adhesive does not have a 
regular pattern from exclusively hexa elements, it will be automatically absorbed as an area connector. 
During the absorption the element pattern, dimensions and tolerance are detected and stored on the 
connector.

A New Mesh Dependent Realization Approach “Smooth” has been Added for the Spot 
Realization

With the smooth option, the mesh will be adjusted in such a way that the closest node to each layer 
is moved into the position of the projection point. The advantage of this option is that neither the 
element IDs nor the node IDs will be changed, and the element topology will remain the same.



New Area Connector Realization Type “Adhesive Hemming”

A new area connector realization type, adhesive-hemming, is now available for Nastran and OptiStruct.

This realization type is used for modeling roll hemmings, where the outer shell is bent around the inner 
shell. The inner shell is connected to the outer shell on one side with simple hexa adhesive, and the 
other side is connected with RBE2 elements. A definable orientation node decides which side the hexa 
adhesive should be used. This seam realization type is capable of connecting three layers that contains 
two components.

New Bolt Connector Realization Type “bolt (threaded step hole)”

A new bolt connector realization type, bolt (threaded step hole), is now available for Nastran and 
OptiStruct.

This realization has the capability of connecting two solids through holes, or connecting one solid 
through a hole with a solid blind hole. A thread length can be defined to define the dimensions of the 
rigid elements connecting the bolt shaft models as a bar.



This realization has the capability to connect two solid through holes or one solid through hole with 
a solid blind hole. A thread length can be defined to define the dimensions of the rigid elements 
connecting the bolt shaft models as bar.

New Spot Connector Realization Type ACM (General)

A new spot connector realization type, acm (general), is now available for Nastran and OptiStruct.

This realization type consolidates several ACM definitions into one general, flexible ACM definition. 
Besides mid thickness, constant thickness and maintain gaps, the definition of several coats with 
different hexa patterns is available.

Other Enhancements

•	 An updated version (2.0) of the XML connector file has been introduced. This new format can be 
read as well as written now. It covers the latest master connection file version 1.1.

•	 The vip file format is now consistent for both import and export. There is no longer an eight column 
fixed format, and the link IDs are always separated by space.

•	 Absorption of the realization type acm (shell gap + coating) is now available. The hexa pattern and 
diameter are detected and stored on the connector.

•	 For the absorption of the Dyna realization type Mat100 (hexa), the check for the correct material 
can now be switched off to allow the absortion of incomplete hexa patterns.

Resolved Issues

•	 The Abaqus realization type fastener assigned the same *FASTENER PROPERTY to fasteners created 
between the same components but with different diameters.

•	 In certain cases the re-realization of the realization type acm (shell gap + coating) with exact same 
settings failed.

•	 In certain scenarios an empty “auto1” component remained after realization.

•	 Certain clear boltholes were not able to be detected, resulting in failed bolt realizations.

•	 The coordinate system for the Hilock realization has been changed from a left handed one into a 
right handed one.

•	 During seam partition, all of the selected seams were unrealized, as well as the seams that were 
not partitioned.

•	 The context menu in the upper part of the Connector Browser did not display properly.

•	 The configurations of the lower part of the Connector Browser was always set back to the default.



Geometry

Enhancements

•	 LCS option for creating surface by drag along vector 

•	 Adding fixed points on ends of surf lines if fixed points are deleted 

•	 Include all points from the original line and project them on the offset line

•	 Improvement trim with plane of surface edit when surfaces are modified by releasing points or 
toggling edges

•	 Function to add fix points at inflection point on the free edges surfaces 

•	 Option detach solid from solid

•	 Creating solid by dragging surface such the generator surface in the middle ( +1/2 and -1/2)

Resolved Issues

•	 Midsurface, sort function delete the elements associated midsurface

•	 Surface and Solids creation panel display problems 

•	 Solid is displayed as collapsed when change to “Auto” as level of refinement

•	 hm_measureshortestdistance2 command cannot search nearest solid in some case 

•	 Auto cleanup – crashes HM are fixed

•	 Detach solids selectively

•	 Robustness improvement to IGES, JT, CATIA and Parasolid and UG import are added

•	 Many bugs related reject operations are fixed in the Geometry panel

•	 Creating smooth lines using nodes is improved

•	 Tangent line creation option is improved

•	 Many improvement to midsurface creation are added

•	 Many solid edit options are improved 

Graphics

Performance Improvement

Major performance improvements for handling of geometry models. Interactive dynamic operations 
such as pan, zoom, and rotate are substantially faster than the previous release. The handling of 
geometry models feels more lightweight reducing any perceived lag when moving the model in the 
graphics area.  Faceting time has also been improved.

New “By Element Quality” Visualization Mode

This new visualization mode enables a perpetual element quality visualization representation 
regardless of which operations are being used. The visualization mode allows you to move the mesh, 
for example by morphing or translating nodes/elements, which in turn dynamically updates the 
element quality graphics display. The visualization mode allows the check of multiple element criteria 
at once using a particular color or there is also a secondary mode enabling a more detailed review of a 
specific element criteria, for example max size. Elements of either specific or no interest can easily be 
removed from the display via filtering enabling a quick review of those elements that fail a critieria.



New Element “By Visible” Window Selection

The By Visible selection mode is enabled via the window selection menu (shift + RH mouse button). At 
the bottom of the menu, there is a visible option. Once enabled, it will work for rectangular, polygon 
and circle selection. By Visible selection is only supported for elements.

Tag Enhancements

•	 Within the graphics area, tags are never seen partially anymore. They are fully viewable, or fully 
hidden. This depends on the visibility of the entity the tag is attached to.

•	 Tag labels can be created from the entity ID.



Center of Rotation Behavior

Within the Options > Graphics panel, there is a new option “rotate about mode”. The option defines 
whether the model will be rotated around center of the screen or the center of the model. The option 
is enabled by default which will retain the rotate behavior as per earlier releases. If the option is 
disabled, the rotation will be about the center of the screen (not model) which is the same behavior 
seen in HyperView.

Resolved Issues

•	 There were different scenarios, where the model was flickering during rotation.

•	 Certain model combinations lead to incorrectly colored mesh lines for the mesh preview in the 
Automesh panel. Green mesh lines were shown on green element faces, which made it hard to 
see the mesh.

•	 Many smaller issues in combination with the composite view have been resolved.

HyperBeam

HyperBeam GUI Enhancements

•	 Undo/Redo  

Four buttons were added to the toolbar at the top: undo all, undo last, redo last, and redo 
all. These allow you to move backward or forward through any changes you have applied to the 
currently displayed beam section (dimension changes, part additions, thickness changes, etc.). If 
you switch to a new beam the undo/redo list is cleared for the previous beam. The reset button in 
the Parameter Definition window (lower left) was removed as it was no longer needed.



•	 Moment of Inertia tool  

A button was added to the toolbar named find moments at mouse location.  Clicking the button 
launches an interactive mode; clicking on the graphics screen will display a window showing the 
Y and Z coordinates of the point selected, the Y and Z offsets from the shear center and centroid, 
and the moments of inertia Iyy, Izz, and Iyz for the section relative to the selected point. This is 
useful for determining beam element offsets or making custom beams. Clicking OK removes the 
window and allows you to select another point.

•	 Ruler tool  

A button was added to the toolbar named measure section with ruler.  This button launches an 
interactive mode where clicking on the graphics screen two or more times creates a line similar to 
the way a shell section is created. If two points are selected the dy and dz distances between the 
points are shown as well as the total length of the line. If three or more points are selected only 
the total length of the line is shown. Right-clicking removes the previously selected point.

•	 Scale option

Right clicking on any beam section in the browser will reveal the Scale option.  This displays a 
window allowing you to scale the entire beam section by a given scale factor.

•	 New magenta + symbol drawn in the HyperBeam GUI on all sections where the beam element axis 
is located.

•	 Added check for disconnected parts and error message for shell beam sections.

•	 Import CSV

A new option called Import CSV was added under the File menu.  This option will read 
HyperBeam’s CSV format and create new shell beamsections.  The Import CSV and Export CSV 
options allow you to read and write to HyperBeam without using the .hm file.

New Beam Sections

•	 Cross (Nastran/OptiStruct/RADIOSS, LS-Dyna)

•	 Asym-I (Permas)

A new option called “Import CSV” was added under the File menu bar.  This option will read 
HyperBeam’s CSV format and create new shell beamsections.  The Import CSV and Export CSV 
options allow users to read and write to HyperBeam without using the .hm file.

Meshing

Box Trim

The Box Trim utility has additional mesh controls; the utility is able to remesh around the trimmed 
boundary ensuring a high quality quad dominated mesh. There are several advanced controls to 
specify the mesh size using a criteria file, other advanced controls include the possibility to exclude 
patches of mesh that serve no purpose after box trim – one or more parts could be trimmed 
leaving patches of elements, these can be removed.

Quality Index Panel - Cleanup Tools Enhancements

•	 Interactive nodes/elements modifications are now enabled to allow use of mask-related toolbars to 
hide/unhide elements.

•	 2nd order elements are supported: middle edge nodes of 2nd order elements can be viewed and 
modified/optimized together with corner nodes



Automesh Panel Updates

•	 Enabled element remesh with different element size of selected area with size transition inside or 
outside of remeshing area

•	 Remeshing with “feature edges” option allows update of 1D elements after meshing

•	 Revert biasing direction by clicking on edge 

Newly Added Tools

•	 Element offset panel: added distributed offset to assign different offset value on selected nodes 
for “CFD corners” method

•	 Align Node > use ratio is a new option which projects any selected node in between the two 
selected nodes a predefined ratio.

•	 Min Size check and fix function added in Tetra Mesh Optimization functionality.

•	 2D & 3D drag: added new capability to organize the mesh into original or current component.

•	 CFD Mesh: new option added to create a new component and organize the solid mesh when 
“simple select” and the “comp per volume” option is unchecked.

•	 Second order Abaqus element checks are supported: at corner and mid-points, and, at higher 
order integration points 

Resolved Issues

•	 Added direct access to the param and criteria help from within the param and criteria editor

•	 Fixed issue with *shadingquality() hm.cfg command

•	 Add washer layer creation remesh issue is fixed

•	 Trim hole removes original elements correctly

•	 When in the meshing edit mode (secondary panel) it was difficult to see the editable values as 
they may be obscured by the mesh in the foreground. The editable values, such as node density or 
biasing, are now viewable.

•	 Crash using Quality Index > holes and washers > circumferential option

•	 Crash when in Quality Index panel and deleting a component from the browser

•	 Mid-nodes of hole and washer layer now maintain correct curvature

•	 Overlapping elements were created when moving a hole radially

•	 Solid Map did not create elements if the option “along geom: surfs” was used

•	 Performance improvements for morphing by volume

•	 Second order hexa to tetramesh splitting issue is fixed 

HyperMesh APIs

hm_getconnected2delems

Returns lists of 2D shell elements and nodes that form T-connected, L-connected, Butt-connected or 
Overlap connected welds at component boundaries.



Direction and Plane Selection

APIs hm_getdirectionpanel and hm_getplanepanel have been added to allow users to define a 
direction/vector or a plane from within a script, using the standard panel vector and plane selector 
widgets.

Data Names for Principal Axes

Data names have been added for querying the principal axis values for components and elements, 
both about the global origin as well as the entity COG.

Resolved Issues

•	 hm_blockredraw now properly blocks all graphics operations while it is enabled

12.0.104 Release Notes

Resolved Issues

•	 Field loads in pressures panel was not creating pressures correctly

•	 Ls-Dyna Interface: When using *INCLUDE_TRANSFORM, the include files were exported with offset 
ID’s instead of the original ID’s

•	 Ls-Dyna Interface: When using *INCLUDE_TRANSFORM, the first element in *CONSTRAINED_
NODE_SET is assigned with the incorrect offset ID

•	 OptiStruct Interface: If there are multiple system collectors and all but the first collector is 
populated, upon file import the organization of the system information would become corrupt

•	 OptiStruct Interface: SPCD values are lost on import if the DOF are not defined

•	 The connector browser add links column was not persisted when changing between the different 
browsers

•	 Finding T-connections on symmetric models via hm_getconnected2delems

•	 For certain models, when toggling a geometric edge it could lead to an application segmentation 
error

12.0.102 Release Notes

New Features and Enhancements

Added new API - hm_getconnected2delems – returns lists of 2D shell elements and nodes that form 
t-connections or share edges at component/material/property boundaries.

Resolved Issues

•	 Application error with offset when @StitchingAcrossBodies = “on” is set in ct_reader.ini

•	 TABLE cards with SKIP entries are not imported correctly in the Nastran user profile



12.0 Release Notes - APIs

Part Comparison

New APIs and functionality (hm_compare*) have been added for performing part comparison.  
Comparisons can be performed between CAD-CAD, CAD-FE and FE-FE.  The parts can be located at 
the same position, translated, rotated, symmetric about a plane, or randomly positioned.  Advanced 
results can be calculated and queried.

*feature_replace

*feature_replace has been added, to allow for geometrically replacing a selection of surfaces with 
a second selection of surfaces, reconnecting the new surfaces to the rest of the original surfaces 
according to the original connections.

*createintersectionsegments

The new command *createintersectionsegments can be used to create plot elements showing the 
intersection segments calculated by hm_collisioncheck.

12.0 Release Notes - Connectors

Add Link Panel

The Add Link panel has been enhanced. For adding links from this panel the link conservation settings 
from the connector options are taken into account now. The Connector Options button has been 
added to this panel. Furthermore the option Add Link from Scratch has been added. With this option 
activated, the former existing links are removed before the new links are added.

New Bolt Realization Type

For Nastran and OptiStruct a new bolt realization type has been introduced. This bolt is intended to 
connect one blind and one through hole with each other. The through hole gets an RBE2 spider on both 
ends, which are connected by a CBAR element. The blind hole gets also two RBE2 spiders, one at the 
open end and the other underneath the end of the counter bore to represent the thread. Also here  
both RBE2 elements are connected via a CBAR element. These two constructions are again connected 
with a CBAR element to each other. The exact geometry depends on the dimensions of the holes.

New Seam and Spot Realization Type

For Nastran and OptiStruct a new realization type for both, spot and seam, has been introduced. The 
realizations look very similar to the ACMs or hexa adhesive realizations. The only difference is that 
between the hexa node and the RBE3 node an RBE2 element is introduced. The RBE2 elements bridge 
in a perpendicular manner the distance between the hexa nodes to the connected shells.

Nastran Realizations

For Nastran realizations using the post script prop_nastran_acm.tcl new components, properties 
and materials have been created per each new realization operation. This has been modified and 
the creation of those collectors happens based upon the realization type now. For example, if a spot 
realization of type “ACM (detached-(T1+T2)/2)” is done, the following collectors are created:

a.   Solid elements will be organized into Component by name:  solid_spot_acm_detached

b.   RBE3 elements will be organized into Component by name:  rbe3_spot_acm_detached



c.   Property will be created by name:  solid_spot_acm_detached

d.   materials will be created by name: solid_spot_acm_detached

New components, properties and materials will be only created when they don’t exist. Otherwise the 
existing collectors are used.

Resolved Issues

•	 For various projection methods during link detection and realization only normal projections are 
allowed. In the past an angle of 5° was considered as normal to cover some of the border cases. 
This angle has been increased to 10°.

•	 In certain situations the connector imprint functionality kept the nodes of the former mesh, where 
the imprint has been applied to. These nodes are invalid and not created anymore.

•	 Using a seam connector on a surface edge to realize a t-connection between two surfaces led to 
wrong results, in case of a small gap between the surfaces. This realization case works independent 
on the surface distance now.

•	 It is possible now to realize spot connectors in combination with quad transition between two layers 
of the same component. That led to failed connectors in the past.

•	 In some cases the realization of area connectors as type hexa adhesive led to flipped hexa 
elements. This issue was caused by a wrong order of some test points.

•	 Connector realizations of type CWELD will fail now, if the both parts to be connected have the same 
property ID.

•	 In the past during area connector creation per each selected line one area connector has been 
created even though they formed a continuous line. From such continuous lines it’s possible 
to create only one connector now. This is optional and can be activated via the checkbox ‘line 
combine.’

12.0 Release Notes - Geometry

New Insert Planes Option for Auto Midsurfacing

A new “insert plane” option in midsurfacing allows auto recognition of the planar plates and 
constructing the plate midsurface as a piece of the exact plane. This may significantly improve results 
for the models with many ribs.

Solid Trimming with Plane Perpendicular to an Edge

This new capability allows you to quickly cut a solid with a plane perpendicular to an edge. The 
capability utilizes a new graphics manipulator which enables a greater level of control as to where the 
trim will occur. It enables very localized trim operations and therefore prevents trims occurring on 
undesired parts of the model.



Three Node Circle Radius

The Distance panel now provides an immediate display of three node circle radius without the need to 
create a center point to know the radius. 

New Lines “by attached” Selection Option

Line collectors have now a new by attached capability. This applies only to topological lines, not to 
free lines as they do not have connectivity.

After selecting by attached, all lines connected to the first one are selected:

Resolved Issues

•	 Temporary nodes were disappearing from graphical display when user was using shorter distance 
tool. This is not the case anymore.

•	 When using Create in lines component option in surface drag planes, surface was incorrectly 
created in the current component. Surfaces are now created in the lines component.

•	 With specific model it could happen that HyperMesh becomes unresponsive during midsurface 
generation. HyperMesh can now properly generate midsurface from those models without becoming 
unresponsive.



•	 When deleting a surface, all masked surface attached to the deleted surfaces would become 
unmasked. HyperMesh now keeps masked surfaces attached to a deleted surface as masked.

•	 With specific model it could happen that midsurface was not generate correctly around holes. 
HyperMesh can now properly generate midsurface around holes from those models.

•	 Geometry editing panels would not refresh properly when user profile was changed. Geometry 
editing panels now refresh properly after change of user profile.

•	 With specific models it could happen that solid editing did not work as expected. Solid editing has 
been enhanced to be more robust and works in more situations.

•	 With specific models it could happen that surface editing did not work as expected. Surface editing 
has been enhanced to be more robust and works in more situations.

•	 With specific models it could happen that Boolean operations did not work as expected. Boolean 
operations have been enhanced to be more robust and works in more situations.

•	 With specific models it could happen that generated midsurface had poor quality. Midsurface have 
been enhanced to be more robust and generated higher quality surfaces.

•	 With specific models it could happen that when exporting using Optimize for CAD option the quality 
of the exported model was poor. Optimize for CAD option has been improved to generate higher 
quality models.

•	 Distance panel was reporting distances between nodes incorrectly when using custom axis system. 
Correct distance is now displayed in the distance panel when using custom axis systems.

•	 Creating surfaces using Drag along panel would fail on Linux with the following message: “The 
distance is too small or zero”. Surfaces can now be created using Drag along panel on Linux.

•	 With specific models it could happen that shortest distance of 0 was reported between solids. 
Correct distance is now reported as shortest distance.

•	 With specific models when scaling down then back to the original size some geometry was 
degenerated. Scaling down then back to the  original size do not degenerate geometry anymore.

•	 When using *reparammark command lines were duplicated but kept the same ID in the HyperMesh 
database. Each line now has a unique ID in the HyperMesh database.

•	 With specific models it could happen that points were deleted during surface extension. Points are 
now correctly kept during surface extension.

•	 With specific models it could happen that  meshing with ExtAPI would return the following 
message: “API Error: Problems encountered during topology mapping”. Meshing with ExtAPI now 
works as expected.

12.0 Release Notes - Graphics

Resolved Issues

•	 The rotation center changed for no reason in certain situations on the platform SLED 11.

•	 There was a slow redraw when rejecting an element deletion.

12.0 Release Notes - Meshing

Midmeshing Tool

The new midmeshing tool combines three key ingredients, midsurface, QI optimized mesh and 
midthickness property assignment, into one unified process. The tool is very flexible enabling the user 
to stop the midmesh process at any stage, make model amendments and then continue the process. 



There are many detailed operations all of which are found within HyperMesh itself, for example, Pre-
Midsurface cleanup houses the options to remove logo’s and equivalence the surface edges before 
midsurface extraction.  The tool uses the MidMesh Thickness tool (released in 11.0.120) as the last 
step in the process. Also, the tool has also integrated the various element visualization options within it 
enabling for instant review of the midmeshed output.

Mid-thickness Mapping Value Round Off

Mid-thickness values can now be rounded off so that assigned thicknesses match range interval 
precision in the Map Mid-thickness Tool.

With range interval set to 0.1 and without Truncate thickness to range interval:

With range interval set to 0.1 and Truncate thickness to range interval:



Batchmesher

•	 Batchmesher has improved recognition, geometry cleanup and meshing for fillets.

•	 Batchmesher and Autocleanup have new options in the Parameter Editor for handling fillets:

–– Recognize main fillets strips – Recognizes wide/main fillets and tries to preserve them while 
merging narrow fillets.  The side effect is that more narrow fillets close to the minimal element 
size are not merged.

–– Preserve main edges – Detect and preserve the main edges of wide/main fillets.  The side effect 
is that element quality may worsen due to the addition of more ‘hard’ features.

•	 Suppress narrow fillets and surfaces with width: This allows the user to define the maximum width 
for which narrow fillets and surfaces are suppressed.

Thin Solid Meshing

This new meshing process can create hex/wedge elements for bent sheet metal parts as tetrahedral 
meshes are not suitable or expensive for analysis. This method automatically detects the top and 
bottom surface and extrude direction and creates well suited hex/ wedge element combinations.

CFD Tetramesh

•	 Auto collision detection for boundary layer growth: The boundary layer (BL) reduction step is now 
included into the BL generation routine. During boundary layer generation a collision check is 
performed and the boundary layer thickness is adjusted dynamically.

•	 Advanced parameters for boundary layer generation: Three new options to control the boundary 
layer growth mechanism have been introduced, including a quality focused and a meshing time 
focused set of predefined parameters. Selecting the user defined option will give access to several 
boundary layer parameters which can be adjusted individually for each application.



OSSmooth 12.0 - Connectivity Detection

A new connectivity detection option is available when interpreting the results of a topology 
optimization. This new option provides a more robust design interpretation process by capturing 
important material distribution that could otherwise be missed due to the definition of a single density 
threshold cut-off value.

OSSmooth 12.0 - Draw Recovery

The draw recovery option uses the draw direction input from a topology optimization setup to create 
straight surface walls in the draw direction, in the isosurface interpretation.

OSSmooth 12.0 - Ply Shape Interpretation

Optimized ply shapes from a composite free sizing optimization can now be interpreted through 
this option. During the interpretation process, the boundaries of the ply shapes are smoothened, 
disconnected patches are created as separate ply entities, and options are available to treat very small 
ply regions. Additionally, after the smoothing and interpretation process is complete, a ready-to-run 
OptiStruct input deck is generated using the smoothened ply shapes and updated ply definitions, all 
while preserving the material definition, properties and fiber orientation.

OSSmooth 12.0 - Geometry Recovery and Remeshing

•	 Improvements to the geometry recovery algorithm result in much cleaner and smoother geometry 
interpretation of topology results, with fewer number of surfaces.

•	 Geometry can now be output in PARASOLID and STEP format.

•	 The remeshing algorithm has been improved to generate a FEA-ready mesh with a mapping of 
property data, loads and boundary conditions, setting up the optimized model for a quick reanalysis
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12.0.110 Release Notes

Systems Review

The Systems Review dialog allows you to review the orientations of various element systems (1D, 
2D, or 3D), as well as material and ply systems. Reviewing these systems enable engineers to assess 
the integrity of model and understand the results in significance to the system of interest. Element 
systems can be reviewed to check normal orientations, proper connectivity, or the beam orientations. 
The system plots can be overlaid with Vector and Tensor plots to confirm the results and their 
orientations are making sense. Different display options are available that customize the appearance of 
the system plot.



Composites Post-processing

•	 Material and Ply System Review

Material and Ply systems can be plotted using the Systems Review dialog for the composite models. 
Advanced Result Math template must be selected in the Load Model panel when initially loading 
the model and result file.  In addition, a solver input deck is also required as the model file. The 
systems review can be overlaid with tensor plot for verification.

•	 Tensor plot of Composite Stresses and Strains

Composite stresses and strains can be tensor plotted in elemental, material, global or user defined 
systems. The transformed tensors can be exported to a .csv file for any external processing or 
hand calculations.



•	 Min/Max Ply identification by Name

MaxLayer, MinLayer, and ExtremeLayer plots in the contour panel that identifies the min/max/
extreme values across plies are enhanced to display the names for easy identification of significant 
plies. In prior versions, the legend only showed the internal ID of plies that had maximum/
minimum/extreme value of results across all the plies. A user had to use the Quick query function 
or the Query panel if he wanted to know the actual ply name. Now the ply names are shown 
directly in the contour legend with color coding of individual or a group of plies. Measures, Query, 
and Notes defined for these plots produce the ply name that has the min/max/extreme value, as 
well as the corresponding actual numeric data of the result.

•	 Ply Count

A new aggregation mode called as Count provides a count of layers associated with each element, 
node. Used in conjunction with the Value filter, users can determine the number of plies failing a 
certain value criteria.

1D Element Post-processing

•	 Element Orientation Review

1D element systems can be reviewed from Systems Review dialog. Beams, bars and bushes 
modeled as 1D elements can be reviewed for validation of model, and analysis of direction of 
forces and moments. Different plotting actions for displaying the element system are available. 
1D element system display can be overlaid with vector. Element system review supported for 
OptiStruct and Nastran solvers.

•	 Forces and Moments Vector Plots

1D element forces and moments can be vector plotted. The results are shown as vectors with 
the functionality available to transform the forces and moments to any coordinate system –from 
elemental system to global or to any user defined system. These transformed forces/moments can 
be exported to a .csv file for any external processing or hand calculations. Element orientations and 
vector plots can exist simultaneously. 1D element forces and moments are supported for OptiStruct 
and Nastran solvers.



Overlay of 1D element system with element forces

•	 Shear and Axial Resultants

Vector plotting is updated to provide shear and axial resultant of individual components. Typically 
relevant for 1D element force/moment vector plots, the shear and axial resultants help calculate 
the failure limits of fasteners and joints. Users can select anywhere from a single component to all 
the resultant combinations in one plot with values displayed at the tip of the arrows. The display 
options for Vector plots are now placed into logical tabs (Plot, Display, Legend, Section). 

Value Filter

The Value filter available in the Contour panel allows specifying threshold criteria for processing results 
only in a specific range.  The Value filter discards any values not meeting the specified criteria (greater 
than or equal to (>=), less than or equal to (<=), or a Range). It can be a useful tool for isolating the 
‘hotspot’ areas in a quick manner. Value filter along with the Count aggregation mode allows users 
to count the number of layers meeting a certain criteria (for example, counting the number of plies 
exceeding a failure index).



HyperView Player

•	 Section cuts can be created interactively in the Player from the Quick Section Toolbar and context 
menu. Section cuts with normal directions of X, Y, Z can be easily created, or any arbitrary plane 
orientation by picking 3 nodes. The onscreen manipulator allows users to position the section at the 
desired location or traverse the cut portion of the model. Reversing the plane direction, or setting 
the transparency on the cut portion, along with displaying the clipping plane or not are available 
from the context menu.

•	 Progress bar is shown when loading files or results and animations. This is useful when reading 
large models, giving the user feedback on the progress of the number of steps of animation loaded.

•	 Model Title note can be turned on/off from the context menu.

General Enhancements

•	 Performance of processing results from an Envelope loadcase spanning over hundreds of loadcases 
is improved significantly.

•	 Performance improved for Browser operations of displaying parts with show/hide/isolate on large 
models.

•	 Models can be animated or deformed based on any nodal vector, including user created nodal 
vectors from Result Math. Deformed Panel allows the users to pick a result type to deform and 
animate.

•	 A new extended selection method of “By Face” is supported for element and node collectors to 
select entities on continuous surfaces bound within a feature angle. The feature angle set under 
Preferences > Options > Visualization affects the entities on the face.

•	 A new extended selection method of “By Plane” is supported for element and node collectors to 
select entities lying on a plane. Users can set the tolerance in the plane normal direction to select 
the entities.

•	 The export options for H3D are exposed in a single dialog where the file name is specified. The 
same options are available under Preferences > Options as well.

•	 Entity sets of nodes, elements, parts created in an active session can be excluded from H3D 
export. By default all the sets are written to the h3d file. To reduce the file size, users have the 
option now in the Export H3D Options dialog.



•	 Assembly Hierarchy allows parts existing in multiple assemblies similar to HyperMesh structure. 
The hierarchy will be read from a solver input deck created in HyperMesh, loaded as the model file. 
An environment variable (HV_ASSEM_DUPLICATE_PARTS) should be enabled.

•	 A new preference statement *DefaultMaxFrameRate allows setting the default maximum frame rate 
animation on start up. A value between 1 and 100 is required to be set. This statement can also be 
added to any custom user preference file and will be observed.

•	 Commands for getting status of display area toolbar, command window, and panels have been 
added. These commands are useful in customization scripts to maximize the display area and 
knowing the status of the GUI

•	 The generaci ascii file format (*.hwascii) is supported for MAC.

•	 Node selection by ids can be specified when aligning a video with a model for the 3D image planes. 
This is available for both 2-point and 3-point alignment methods by clicking on N1, N2, or N3 
collectors.

•	 ApplyStyle functionality supports User defined systems. The systems created in one window can be 
copied to other windows by executing the ApplyStyle context menu.

Resolved Issues

•	 Erosion models that exhibit element failures in transient animations are exported correctly into the 
H3D. The resulting file size is also smaller exporting only the displayed elements on the screen.

•	 H3D export bug corrected so that all hidden components are not available after exporting into h3d 
if the “Include masked elements” option is not active.

•	 “Include masked elements” option for H3D export also considered for publishing a session (html or 
ppt) that has animations captured in H3D format.

•	 When working with two PowerPoint files that have embedded HyperView player, double clicking 
to open the h3d resulted in an incorrect file loaded. Unique names for the temporary files created 
resolves the issue and users do not see the issue anymore.

•	 On MAC machines, the Symmetry with respect to markers on an MBD model are restored correctly 
in H3D

•	 Implemented saving and restoring of draw style and draw size for entity sets written out from 
HyperView.

•	 Application crash is prevented in cases a tracking system is deleted from the browser.

•	 Unexpected hang of application resolved when resetting Synchronize animation (from Tools menu) 
using the Video Overlay feature on Linux

•	 HyperView window gets locked after certain copy/paste window operations from the session 
browser. Subsequent operations resulted in application errors. This issue is resolved.

•	 Measures defined between overlaid models are listed in the browser just as the Measure panel

•	 Measures and Note transparency and autohide settings are captured in H3D export to see them as 
saved in HyperView Player.

•	 Measure expressions are correctly offset with page and group ids when used in Report Templates 
with overlay or append mode. Live linked curves pull the data from appropriate measures in these 
situations.

•	 Cascading menu items on Linux machines are refreshed correctly when moving between different 
items.

•	 Symmetry dialog displays any previously selected parts on re-opening it for users information.

•	 Invoking symmetry changes affected the note attachment type from a coordinate to node. This 
issue is resolved



•	 Preference file statement for setting the note fonts, *NoteFont, is considered for notes created 
using “Multi select” operation as well.

•	 Font style correctly captured and restored in H3D with node path measures.

•	 Image capture on Windows XP-32 updated to not include the dialog remnant for captured images.

•	 After reading legacy session files (10.0 or older), the complex results filter was incorrectly set on a 
new session file save. This issue is resolved.

•	 Deformed scale factor was incorrectly reset to 1.0 when loading a session file and saving it again 
without visiting all the pages. This issue is resolved and all the scale factors are saved as they are 
defined in the original file irrespective of switching any pages.

•	 Legend formatting is not applied under Linux when a session file is loaded with fonts that do not 
exist. A fix is implemented to default the font types only and not affect other legend attributes.

•	 Changing the dof’s for a tracking system inadvertently applied a contour if it had been cleared 
previously. Users are forced to clear the contour again. Checks are implemented to see if a contour 
plot exists or not, and updated the tracking system properties does not create a contour plot 
automatically.

•	 Undeformed shape color is captured and restored correctly in window copy/paste operations.

•	 Fixed an issue where the file open dialog of the Sets import/export GUI invokes in the background 
on LINUX only.

•	 No results in hwascii format as shown as N/A instead of zeros.

•	 Node trace is available on reflected parts of symmetry.

•	 TCL plugins (result math operations) on hex 20 noded elements with complex results resulted in 
memory overflow and crash of the application. This issue is resolved.

•	 TCL plugins (result math operations) support complex data also. Results of nodes/elements can be 
extracted for a complex loadcase and math operations scripted in the plugin.

•	 Result math operations can extract yield stress or material ID from the solver input deck for 
materials bound to parts as in the Radioss or LS-Dyna solvers.

•	 Rake outline visibility is captured and restored correctly in H3D Export.

•	 Quick window selection did not work correctly when tracking system is present, wrong entities were 
selected. The tracking system transforms are appropriately dealt now while processing a quick 
window selection of entities.

•	 The HVP plugin registration script, regHVPDll.bat, is updated with proper version of the plugin from 
11.0 to 12.0.

•	 Session file does not get saved when connection to license server is lost even after choosing yes 
to do so. The issue corrected to account for forced shutdown of the application, and save on exit 
on user option. When HyperMesh is the active client at the time of lost license connection, the app 
crashed on saving. This is resolved as well.

•	 Command window closes with “exit” command and could not be opened any more. This issue is 
fixed.

•	 Quick query selection sometimes caused the last entity selection to be used for a next operation 
like contour plots. The selection interference with panel collectors is avoided.

•	 Sessions with multiple windows each having a model at different step increment wasn’t restored 
correctly when a Derived Loadcase existed. The resetting of the simulation index to the first one is 
resolved.

•	 Application errors showed up while dragging the current time slider in Synchronize Window 
Animation dialog. Issue is resolved.



•	 Node path algorithm for Measures updated to use the shortest distance between selected nodes.

•	 A regression introduced in v12.0 of HyperView is resolved where the thickness of border of notes 
and the leader lines are different.

•	 The magnitude calculation for Incremental Distance is corrected to vector addition rather than a 
straight difference of magnitudes of two vector positions.

•	 A better algorithm for Iso-surface is implemented that handles solids having one or more “No 
Result” nodes.

•	 When reading partial input decks that have grid and element definitions in multiple include files, 
the model renumbering was happening subsequently causing wrong results to show. This issue 
is resolved by updating the model correctly accounting for removed elements that had invalid 
connectivity.

•	 HyperView Player on Linux crashed while loading very old h3d files (created v7.0 or prior). The 
legacy reader is updated to handle this case.

•	 Minor update to the H3D Export Settings dialog to accept integers and floating point numbers for 
the compression factor. Application error or no compression resulted previously using integers or 
blank in the entry field.

•	 Application crash prevented when using Preference statement *NoteAttachment(“Node”) for note 
attachment.

•	 GetValueList API on measures crashed the application when querying entities that do not have any 
results. This issue is resolved now and should help automation scripts that unknowingly query for 
the entities with N/A values.

•	 Users can launch “Optistruct” and “Radioss” solvers through  “Applications è OptiStruct/Radioss” on 
Linux and Mac machines which wasn’t possible before due to an issue in the invoke script.

•	 When evaluating Envelope derived loadcase on files generated from Radioss, LS-DYNA, or 
PamCrash natively or converted to H3D, the results for the aggregation were incorrect in certain 
cases. Checks have been added to handle these scenarios.

•	 Note AutoHide setting was not respected in image screenshot or PowerPoint export. The logic in the 
rendering code is updated to consider the setting when capturing images.

12.0.102 Release Notes

Resolved Issues

•	 Application error while dragging the current time slider in Synchronize Window Animation dialog

•	 Session file contents were removed when connection to license server is lost 

12.0 Release Notes

Symmetry Visualization

Symmetry visualization allows partially modeled geometry to be shown in full extent by reflection and/
or duplication. Computational efficiencies are gained by modeling only partial geometry to the solver 
with appropriate boundary conditions, and visualization the full model in HyperView. Multiple planes 
of symmetry are supported. In conjunction with planar reflection, users can copy the geometry in 
rectangular and circular manner. Global directions or user specified local axis is supported. Result plots 
like Contour, Vectors, and Tensors are also shown on the reflected geometry. Symmetry settings are 
saved in the H3D files for visualizing the full geometry in HyperView Player.



3D Stereoscopic View

HyperView supports stereoscopic 3D viewing to visualize simulation data in 3D. The visualization mode 
enables engineers to organize design reviews with other users and management in high end graphic 
visualization in a 3D environment using the Perspective view and depth perception. As a design review 
tool, the 3D stereoscopic views allow detailed analysis of the physical event being simulated.  Modeling 
of spatial reality aids in enhanced interpretation of results within the familiar 3D environment.

Section Cuts with Path Plots

Result variations along a section cut can also be studied by defining a node path along the cut. This 
helps engineers to assess the variation of a result along a user specified path on a cut section, as an 
example thickness variation in a stamping process. Measures can be defined on the nodes of a cross-
section enabling a deeper analysis of the deformation of the section. Typical applications of measuring 
values on the cross section include plotting the position or distance between nodes on the cross-
section, as measuring the intrusion. 



Isosurface on Parts

Isosurface can be applied on selected parts, as an example on fluid elements, while visualization the 
structural components in full. For ditching simulation or fuel tank sloshing modeled with multiple fluids, 
the isosurface generates the fluid boundaries without influencing the structural components.

Measure Fonts and Colors

Font types and colors can be set for measure groups separately. The controls are similar to Notes with 
the flexibility to adjust the size, type, and color.

General Enhancements

•	 Assemblies are supported for the Selector, and Show/Hide/Isolate modes from the browser. This 
allows the users to review all the parts in the assembly by just selecting any part on the graphics 
area. Similar to the component review modes, holding the left mouse button down, the middle 
mouse scroll wheel can be used to depth zoom inside the model for selecting different assemblies.



•	 An entry field for notes allows inserting only the file name of the result file or the model file without 
the complete path of the directory structure.

•	 Publishing into PowerPoint is enhanced by allowing users to specify a master template or optionally 
control the resolution of the images. See the HyperGraph section for more details and the features 
supported.

•	 H3D files can be embedded in PowerPoint by a drag and drop operation, and viewed by HyperView 
Player in-place during slide show modes.

•	 The cross-section manipulator is updated to a 3D manipulator for X, Y, or Z-normal planes. The 3D 
manipulator can then be translated in any of the 3 directions to adjust the base point.

•	 Native dialogs on Windows Operating systems for File Open and Save show the Recent Places, 
Favorites, and the mapped network locations on the side for frequent access. Also, the drop down 
for file name entry field shows the recently accessed files.

•	 The information about a result math template used to load a particular model is shown in the Model 
Info tab (right click in the browser to select Model Statistics). It is particularly useful when loading 
from a session file to know what template has been specified for a given model.

•	 Improved graphics output during image capture and printing is implemented. Printing high quality 
images and captured images appropriately capture the graphical elements like notes, vectors, 
measure texts, legends and global triad, so that these elements scale up in resolution/sharpness 
along with the rest of the output.

•	 Ply names are sorted in alpha-numeric manner for convenience in the layer filter dialog.

Resolved Issues

•	 Captured images from the command layer adhere to the resolution specified in pixel dimensions.

•	 PowerPoints with embedded HVP objects are no longer restricted to the machines that created 
them. The embedded H3D file in the PowerPoint can be opened across user machines.

•	 The node path drawing is optimized to provide an improved frame rate when a lot of text is 
displayed on the path. This is more prominent with a node path covering a large number of nodes 
and text like id and values are displayed on the path.

•	 Application crash resolved when using the Entity attributes panel with Assembly Hierarchies in 
certain cases.

•	 Due to a regression introduced in an earlier patch, measures could not be created from the 
Advanced Query dialog. This issue is resolved.

•	 Improved performance in View synchronization operation between HyperMesh and HyperView 
windows that are coupled side-by-side.

•	 A significant improvement in changing the visualization options when dealing with large number 
of parts. Changing modes like wireframe to shaded or transparent with feature lines etc are much 
quicker from the Toolbar buttons or Entity Attributes panel.

•	 Deleting pages from that Session Browser that are not active caused a few refresh issues in the 
graphics area. The refresh issues are addressed.

•	 CaptureAnimation API has been updated to correctly handle special characters like “.” specified in 
the file path. A related issue resulted in truncation of filenames when capturing GIF files or other 
video formats from the Image Capture Toolbar and filenames have a “.” period. Both of these 
issues are resolved.

•	 Transparency settings from the Display Options is correctly applied when Accelerated Graphics is 
active.

•	 Multiple issues in FLD panel are addressed that involving Copy/Paste page, reading data from a file 
or selecting components on the screen with Copy/Paste.



•	 The templex expression for Live linked curves get updated to relevant measures when applying 
report templates in overlay modes.

•	 Deformation scaling is correctly captured and applied from report templates.

•	 Application crash issue resolved when reading a session file with invalid datatype names created as 
result math expression (for example a “.” period). A warning is posted instead.

•	 Result math plugin scripts give access to any optional arguments (strings) passed to the script. The 
plugin scripts can be Templex/Tcl/HyperMath, which accept optional arguments in addition to the 
datatype.

•	 Performance restored with automation scripts that don’t properly release stacks of “handles” used 
in the script.

•	 When creating an Iso plot and turning on the Color option, the color selected did not get applied to 
the entire set of parts visible. It only applied to a portion of the model that is “cut” by the Iso. This 
issue is resolved now.

•	 Preference statement to control the visibility of gridlines for section cuts is implemented to work 
correctly whenever new sections are created.

•	 Plot styles that are saved with datatypes names having special characters like &, % etc are 
restored correctly on import.

•	 RADIOSS Animation files exported to H3D with compression correctly captures the erosion state of 
the model.

•	 The model disappearance in perspective view when zoomed in too far is corrected by adjusting the 
clipping plane.

•	 Notes and Query updated to return all the components of the tensor (normal and shear) when 
queried.

•	 Precision of numeric calculations for principal values on a tensor is improved to reduce round off 
errors.

•	 The default text alignment in Notes is changed to left, unless overridden in the preference file by 
some other value. Model info note will always have the text alignment as “right”.

•	 HyperWorks Desktop window pops back on top while loading session file interfering with other 
applications. The issue is resolved so that the only time the main application window pops to the 
top is when an error is posted to the message log and the message log window is displayed.

•	 The Expression Builder for result math is updated to accept numbers with higher precision up to 12 
digits after the decimal.

•	 Report templates with a group measure (single curve) restores the live linked curve correctly. The 
measure Templex expression wasn’t getting parsed correctly earlier.

•	 Performance improvement made to turning on/off the display of assemblies from the browser.        

•	 Preference statement to set a user defined starting orientation of the model, *SetOrientation, is 
supported to work correctly. Possible values are top, bottom, front, back, left, right, iso. Once the 
model is loaded, the view orientation will be set based on the value of this preference statement.

•	 Application hang resolved in some situations when a rapid dynamic zoom is performed in and out of 
the model. The mouse click processing is adjusted to sequence the operations

•	 The 3 point alignment for positioning 3D image planes is made robust for different formats of the 
video files.        

•	 The display icons for components of an assembly is updated correctly in the browser after isolate 
operation on assemblies or parts.

•	 Note and Measures autohide state is correctly represented in the Image Capture.        



•	 Model rendering code updated to handle certain cases of deformable cross section cuts not showing 
the elements correctly.

•	 H3D export updated to show right animations for a model that has tracking system applied on 
hidden parts at the time of export.

•	 Updating a cross section from planar to deformable should no longer affect the eroded elements 
display.

•	 Query panel export of csv or HTML throws up an error when a model input deck has empty parts in 
it. The application error is subdued in those situations.

•	 Video capture code is corrected for Mac to show the graphics area content during Capture dynamic 
rectangle video.

•	 Derived loadcase API is restricted from allowing recursive additions of same loadsteps any more.

•	 The compression factor set is Export Options for the H3D also gets applied to the H3D files of the 
Published HTML reports.

•	 Streamlines are captured in H3D generated from a Published HTML.

•	 The mesh visualization style is not applied until selected from the browser. Previously, just bringing 
up the pop up dialog changed the mesh visualization mode.

•	 Multi-select option is disabled for node path measures as the selection is order dependent.

•	 The browser interface is refreshed instantly to reflect up to date information of loadcase and 
timestep. There are many instances in the GUI that was not up to date with the active loadcase 
and loadstep, unless the browser view was manually refreshed or changed to a different view. 
These are the situations of stopping animation at random time steps, or changing a loadcase or 
loadstep using the keyboard shortcuts like “Insert”, “Delete”, “Home”, “End”, “Page Up” and “Page 
Down” buttons. The loadcase and loadstep changes are updated in the browser entry immediately. 
Also, when the animator’s current time is changed, the simstep entry in the browser (loadcase 
view of browser) is made bold. Conversely, when current simstep is changed using context menu in 
loadcase view, the dropdown entry for simulation is updated in the browser.

•	 Session loading restores correctly and without any errors derived loadcases defined across multiple 
result files.

•	 ApplyStyle is updated to include corner data setting for Tensor plots.

•	 Measure API GetValueList to get item list for node path measure returns only a single list now. Any 
scripts using this API would have got duplicate lists earlier.

•	 Model Info dialog provides more detailed information about element types and their count.

•	 Rotation speeds of the models in the graphics area is maintained unaffected by the animation 
speed set to lowest. Sluggish rotation resulted earlier when the animation slider was set to the 
lowest value.

•	 Copy/paste of HyperView windows maintains the undeformed model display settings.

•	 A session file loaded from a command prompt or double click in Windows explorer correctly loaded 
the model and result file, however, the session did not remain active prompting the user for a file 
name when saving. This issue is resolved.

•	 The Previous View behavior is made consistent between HyperView and HyperMesh

•	 A negative multiplier for contour is enabled.
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Plot Browser

The HyperGraph 2D Plot Browser is located on a tab in a tab area sidebar.  It allows you to drive the 
application and view your session’s current plot structure, which is displayed in a tree structure within 
the browser.  You can also perform many of the functions available in the HyperGraph panels through 
the Plot Browser, allowing you to modify your plot and curve properties in one location.  This includes 
the following:

•	 Perform Single Curve Math and Multiple Curve Math functions

•	 Rename curves

•	 Modify the following curve properties:

–– Curve attributes

–– Axes

–– Plot options

–– Notes

–– Datum lines

–– Plot macros



Some of this functionality can be accessed through the Plot Browser’s context sensitive menu, while 
some are accessible through the Properties Table in the Plot Browser.

The Plot Browser can be turned on or off using the View > Browsers > HyperGraph 2D > Plot 
menu options. A check mark indicates that the HyperGraph 2D Plot Browser is activated for display in 
the tab area. The Plot Browser can also be positioned to appear on the right side of the page (the right 
tab area).

Property Micro Dialogs

In HyperGraph, Property Micro-dialogs contain a subset of the most common functions performed by 
users.  To access a micro-dialog, double-click on a plot “element” to displays the micro-dialog at that 
location.  For example, if you want to modify the header properties, double-click on the header to 
display the micro-dialog at that location.  Micro-dialogs are available only for the XY plot type.



Build Plot Advanced Options

The Advanced Options feature on the Build Plots panel allows you to apply many options at once 
to the session during plotting.  Curves created in this manner are added to the session in a new layer.  
From the Build Plots panel, click Adv. Options to display the Advanced Plot Options dialog.

The Advanced Plot Options dialog contains a tree on the left side and the Properties Table on 
the right. From the tree, you can select the plot entity that you want to apply to the curve. The 
Properties Table lists the properties and current values for the selected plot entity.

Note: A curve must be specified in the Build Plots panel before you can apply options to it 
using the Advanced Plot Options feature.

Math on Curves Prior to Plotting

The HyperGraph Math on Curves prior to plotting feature allows you to use additional curve vectors 
to plot a curve.  In addition to the traditional X and Y vectors, you will now be able to make use of U 



and V vectors to perform operations on a curve at plotting time.  Thus, only one curve is generated 
in the session whereas in the older versions of HyperGraph, this could not be done without an initial 
curve.

To access the Math on Curves prior to plotting feature, select the Define Curves panel.

This is helpful any time you want to create a curve and immediately apply a function (for example, a 
filter) to that curve.

Previously, you had to create and plot the base curve, and then create subsequent curves which 
referenced the first (base) curve to perform the functions. The new Math on Curves prior to 
plotting approach simplifies this.

When you click Apply, the specified curve is created, using the vectors U and V, plus any math applied 
using X and Y.

Custom Plot Types

Plots can be customized to be displayed as other plot types, such as Gauge, Pie, 3D Bar and more.  
Scripts have been included in HyperGraph 2D to display these custom plot types.  Two of these scripts 
contain context sensitive menus to activate the override option for the plot window.

From an XY plot type, right-click in the plot window to display the context menu. From the Custom 
Plot Types context menu option, select Gauge. The Gauge plot type supports most XY features, such 
as Max/Min, Fixed or Scientific Notation, two Datum Lines (Red and Yellow only), fonts and more.  
Some XY plot features are not supported. This feature is designed for the first curve in a window only.  
See the example images below:

From a bar chart, you can right-click in the plot window to display the context sensitive menu.  From 
the Custom Plot Types context menu option, select Pie Chart. The Pie Chart plot type supports most 
bar chart features such as Datum Lines, Fonts, syntax and more. Some bar chart features are not 
supported.  This feature is designed for a single catalog in a window. See the example image below.



These scripts can be found in the [installation directory]/utility/scripts/plotting/
overrides.  These scripts can easily be modified to generate other custom plot types.

To turn off the custom plot type, right-click in the plot window, select the Custom Plot Types menu 
option and click None.

Resolved Issues

•	 Cross plotting animation files:  Fixed the bug with cross plotting Data Types with animation files

•	 Axis Auto Fit has been corrected. To fix an axis, uncheck Auto Fit.

•	 Circle zoom has been fixed when working in the Coordinate Info panel

•	 Memory leak upon loading session file multiple times

•	 Proper reading of PLT files

•	 Linux: After using Export > Curves, user can’t expand another menu without escaping from 
previous one first

•	 Improved unv reader

•	 9.0 session file are fixed

12.0 Release Notes

PowerPoint Beta

The HG PowerPoint Beta functionality is the commercialization of the MVP toolbar’s Export functionality.  
This tool is an improvement to our current PowerPoint publishing capabilities, and was generated by 
our AEs in the field.  It is a great example of how customizable our HWD products are.  The PowerPoint 
Beta feature provides more options when generating Microsoft PowerPoint files. Engineers spend a lot 
of time generating these PowerPoint files for their managers and customers.  This enhanced feature 
will make generating these reports much easier, decreasing the work of the engineer and allowing 
more time for engineering.  This is done by providing users more control over the way the PPT will look 
before publishing.

Known Issues

•	 PLT files are not reading the Data types properly, and you can get the wrong list in the component 
fields.

•	 Reader Versioning does not work correctly, and the DLLs need core fix.



What to expect when Publishing from each client (HM/MV/HV/HG/TextView/MediaView):

•	 HyperMesh – Image only

•	 MotionView – Image only

•	 HyperView – Image or H3D

•	 HyperGraph – image only

•	 TextView – Editable Text box (if your text expands outside the window, it will extend outside the 
text box in PPT.)

•	 MediaView – Image only

•	 HG3D – Not yet supported

Features:

•	 Title PowerPoint Beta

•	 Support of PowerPoint Master Templates

•	 Support of Title Attributes and Position

•	 Support of Image Positioning

•	 Support of Picture Resolution

•	 Support of Page/Window Export Selection

•	 Support of one window per PPT page

•	 Support of Font Settings for HyperGraph & HyperView objects

•	 Support of H3D Export Options



MotionView 12.0.110 Release
The 12.0.110 release of MotionView contains significant enhancements in the areas of extensions tailored 
for the automotive industry, core modeling capabilities and bug fixes.

The major changes to MotionView include the following:

•	 Vehicle Dynamics tools

•	 Joint friction support for MotionSolve

•	 Handling shared definitions

•	 CAD import enhancements

•	 Flex body enhancements

•	 Project Browser enhancements

Contents

Vehicle Dynamics Tools

Joint Friction For MotionSolve

Shared Definitions

CAD Import Enhancements

Flex Body Enhancements

Project Browser Enhancements

Other Enhancements

Resolved Issues

Known Issues

12.0.104 Release Notes

12.0.103 Release Notes

12.0 Release Notes

Highlights of the

Introduction

MotionView is a user-friendly and intuitive multi-body systems modeling environment. Its built-in 
parametric modeling capability and open architecture allows you to quickly build, analyze, and improve 
mechanical system designs even before physical prototypes are available. Coupled with a next generation 
solver, MotionSolve, MotionView provides the perfect solution for your multi-body simulation needs.

This document describes changes that have occurred to MotionSolve since February 2013. All of these 
improvements are available in HyperWorks 12.0.110.



Release Notes

Vehicle Dynamics Tools

MotionView now includes new vehicle dynamics preference. New entities are available for modeling 
bushings, springs, dampers, rebound-stops, bump-stops and tires in vehicle dynamics applications. 
These entities support Tiemorbit property files along with reuse of common Adams/Car™ property 
files with your MotionView and MotionSolve models. The table below provides an overview of the new 
entities. The MotionView online help describes how to add these entities to your model. Use of the 
vehicle dynamics tools requires installation of HW-Solvers 12.0.210. The solvers patch provides the 
physics necessary to simulate the vehicle systems that are created with MotionView 12.0.110.

Entity Functions Features Application
Bushing

(autoBushing)

Elastically mount 
suspension arms, links, 
sub-frames, engines, 
gearboxes, etc. to 
vehicle chassis

•	 Exerts force and 
torque in all 
directions.

•	 Non-linear force/
torque verses 
deflection 
interpolated from 
tabular data using 
Akima’s method

•	 Linear damping

•	 Suspension 
kinematic and 
compliance 
analysis

•	 Vehicle 
Dynamics

Bump-stop

(autoBumpstop)

Limit suspension bump 
or jounce travel

•	 Exerts a force along 
a line to repel two 
bodies when the 
distance between the 
bodies is less than 
the threshold

•	 Non-linear force 
verses deflection 
interpolated from 
tabular data using 
Akima’s method

•	 Linear Damping

•	 Vehicle 
Dynamics

•	 Durability

Damper

(autoDamper)

Dissipate energy stored 
in springs and damp 
chassis motions

•	 Exerts a force along 
a line between two 
bodies

•	 Non-linear force 
verses velocity 
interpolated from 
tabular data stored 
in a property file 
using Akima’s 
method

•	 Vehicle 
Dynamics

•	 Ride Comfort

•	 Durability



Rebound-stop

(autoReboundstop)

Limit suspension 
rebound travel

•	 Exerts a force along 
a line to attract two 
bodies when the 
distance between 
the bodies exceeds a 
threshold

•	 Non-linear force 
verses deflection 
interpolated from 
tabular data using 
Akima’s method

•	 Linear Damping

•	 Vehicle 
Dynamics

•	 Durability

Spring

(autoSpring)

Limit forces in 
suspension components 
and isolate chassis by 
absorbing energy from 
vertical road inputs

•	 Exerts a force along 
a line between two 
bodies.

•	 Non-linear force 
verses deflection 
interpolated from 
tabular data using 
Akima’s methods

•	 Optionally set the 
initial load or length 
of the spring at 
vehicle input position

•	 Suspension 
Kinematics and 
Compliance

•	 Vehicle 
Dynamics

•	 Ride Comfort

•	 Durability

Tire – CTI

(autoTireCTI)

Generate forces for 
steering, accelerating, 
and braking. Isolate the 
vehicle from small road 
irregularities

•	 COSIN FTIRE 
(flexible ring), FIALA, 
and Pacejka 2000 
Magic Formula tire 
models

•	 3D and 2D Road 
Models including 
Curved Gridded Road 
(CRG) and COSIN 
RGR.

•	 FTIRE: Ride 
Comfort & 
Durability

•	 Pacejka 2000: 
– Vehicle 
Dynamics

Tire – CD

(autoTireCD)

Generate forces for 
steering, accelerating, 
and braking. Isolate the 
vehicle from small road 
irregularities

•	 Supports family 
of CD-Tire models 
(flexible ring)

•	 2D and 3D Road 
Models including CRG

•	 Vehicle 
Dynamics

•	 Ride Comfort

•	 Durability

Tire – TNO

(autoTireTNO)

Generate forces for 
steering, accelerating, 
and braking. Isolate the 
vehicle from small road 
irregularities

•	 MF-TYRE

•	 SWIFT-TYRE (rigid-
ring)

•	 2D and 3D Road 
Models, including 
CRG

•	 MF-Tyre: Vehicle 
Dynamics

•	 SWIFT-
Tyre: Vehicle 
Dynamics & 
Ride Comfort

To learn more about auto entities, refer to the MotionView User Guide at MotionView -> Vehicle 
Dynamics Modeling -> Auto Entities.



Joint Friction For MotionSolve

MotionView now supports static and dynamic friction in joints defined for MotionSolve. Friction 
properties can be defined for Revolute, Translational, Spherical, Universal and Cylindrical joints. 
Symmetry is supported. MotionSolve uses the well-known LuGre friction model for these joints.

To learn more about joint friction support for MotionSolve, refer to the MotionView User Guide at 
MotionView -> MotionView Panels -> Joints Panel -> Joints Panel – Friction Properties Tab

Shared Definitions

Entities such as Systems, Assembly and Analysis, (referred to as definition based entities) are created 
through an instantiation statement in the MDL that refers to a definition block. It is possible that 
multiple instances can be instantiated off of the same definition block. Such instances are referred to 
as shared instances or linked instances. Below is an example model containing shared instances.

*BeginMDL( the_model, “Model”, )

 *System( sys_0, “System 0”, def_sys_0 )

 *DefineSystem( def_sys_0 )

// sys_1_shared uses definition def_sys_1

   *System( sys_1_shared, “System 1”, def_sys_1, p_0, p_1 )  

// sys_2_shared also uses the same definition def_sys_1

   *System( sys_2_shared, “System 2”, def_sys_1, p_2, p_3 )    *Point( p_0, “Point 0” )

   *PointPair( p_1, “Point 1” )

   *Point( p_2, “Point 2” )

   *PointPair( p_3, “Point 3” )

   *SetPoint( p_0,                        0.0, 1.0, 10.0 )

   *SetPoint( p_1,                  LEFT, 0.0, -10.0, 0.0 )

   *SetPoint( p_2,                        0+10, 1.0, 10.0 )

   *SetPoint( p_3,                  LEFT, 0.0+10, -10.0, 0.0 )



 *EndDefine()

// Definition block def_sys_1 begins

 *DefineSystem( def_sys_1, p_att1, p_att2 )                        

   *Attachment( p_att1, “Attachment point 1”, Point, “Select attachment.”, ,  )

   *Attachment( p_att2, “Attachment Point 2”, PointPair, “Select attachment.”, ,  )

   *Point(p_in_shared, “Point in shared def”)

   *Body( b_0, “Body 0”, p_att1, , , ,  )

   *Graphic( gsph_0, “Sphere 0”, SPHERE, b_0, p_att1, 2.0 )

   *BodyPair( b_1, “Body 1”, p_att2, , , ,  )

   *GraphicPair( gbox_0, “Box 0”, BOX, b_1, CENTER, p_att2, ZX, VECTOR, V_Global_Z, 
VECTOR, MODEL.V_Global_X, 2.0, 2.0, 2.0 )

 *EndDefine()                                                        

// End Definition block

*EndMDL()

MotionView 10.0 GUI and earlier versions handled shared instances as though they originated from 
different definitions. Once the model with shared instances loaded in MotionView and any of the shared 
instances got modified, the linkage was severed and MotionView saved the instances by referring them 
to different definitions. This inherent behavior was lost from version 11.0 onwards. E.g. Modifying a 
system instance by adding, deleting or changing the topology of an entity within, resulted in the same 
change being applicable to the other instance that shared the same definition as the system

From version 12.0.110, better support for shared instances has been provided in the MotionView GUI.



–– The browser indicates the sharing between instances with a separate hand icon appended to 
the standard icon of the entity.

–– The user has a choice of breaking linkage automatically when modifying a shared instance. A 
new option is available under Tools -> Options -> Build Model to control how shared instances 
should be handled while modifying them

–– Right click context menu in browser provides option to list shared instances as well as stop 
sharing the definition

To learn more about managing shared definitions, refer to the MotionView User Guide at MotionView -> 
MotionView Overview -> Container Entities -> Managing Shared Definitions.

CAD Import Enhancements and Updates

MotionView now supports using the new CT reader in HyperMesh. The CAD import utility now has 2 
options for UG import. A faster import time is observed while using the new reader compared to the 
existing UG native reader.

Resolved Issues

–– Issue of Parasolid imports that results in several parts being combined into fewer bodies is 
resolved

–– Issue related to failure of import while specifying Locator points has been resolved.

Flex Body Enhancements and Updates

Dummy bodies are now automatically added while exporting flexible body to Motionsolve when there is 
an offset between the interface node and corresponding marker. The dummy body is included when the 
offset exceeds the specified tolerance.

Product of inertia sign would appear reversed in Body Deformable panel compared to previous 
versions. This change makes display of inertia information in this panel consistent with the convention 
prevalent in MBD solutions.

MotionView now exports ModeLoad section to MotionSolve XML whenever the flex body h3d contains 
modal loads

Flexbody generation tool used to lock the .out file resulting in non-usability of the tool using the same 
output filenames. This issue has been resolved 

The mirroring feature in FlexBody Generation tool reported erroneous inertia values in cases of 
mirroring about XY and YZ plane. This issue has been resolved.

Project Browser Enhancements

Performance improvements:

–– Faster response times when opening models and updating the browser. For example, a full-
vehicle model with sixteen analyses now opens 15-35% faster than prior releases.



–– Performance bottlenecks in the Browser’s ‘Delete’ operation have also been removed. The time 
it takes for the ‘Confirm Delete’ pop-up to appear is much quicker now, especially when the 
number of items being deleted is large.

–– Color changes made through the browser now propagate more quickly than in previous 
releases; we have seen 30-50% faster times when cascading a color from parent to its children 
using this release.

Progress reporting: The status area below the Project Browser now reports progress when opening 
models with messages:

–– ‘Loading Model…’

–– ‘Populating the browser…’

New keyboard shortcuts: Additional keyboard shortcut for the Project Browser have been enabled. 
(Refer to the Online Help for other supported keyboard shortcuts.)

–– Ctrl+A is enabled to ‘Select All’ entities in the Project Browser.

–– Ctrl+\ is the shortcut for ‘Unselect All’ entities

–– Shift+Delete now allows you to delete immediately, without being prompted by the ‘Confirm 
Delete’ dialog.

Other Enhancements

•	 The Mesh and Shade options in the Visualization tab of Graphics entities are reorganized to 
streamline with the possible options available:

•	 Model Selection Behavior:  Selecting the model from the Project (or using Model > Select from 
the graphics window) no longer highlights everything in the OpenGL window. This helps to avoid 
the ‘cluttered’ look of having everything in the model shown selected in white. Note that the panel 
area still updates to show the System panel corresponding to the model, as expected.

•	 MotionView templex functions now supports appending ‘d’ as a keyword to suggest angles being in 
degrees

Resolved Issues

•	 An application error related to toggling of a marker as Floating marker is resolved.

•	 Load Export now supports export of loads due to field entity.

•	 Add Assembly dialog ignored the Attribute “Type” while adding or reselecting assembly using 
existing data. This issue is resolved.

•	 Entity selected in browser of a MotionView window is lost when changing between multiple 
MotionView windows. This issue is fixed.

•	 Application error was observed in the CG Inertia Summary due to unresolved references in the 
Inertia Coordinates tab in the Body panel. This issue is fixed.

•	 File fields (such as in Deformable panel) show parametric references with the blue color 
background.



•	 *RegisterSolverScript and RegisterReportsLog specified in a user preference is not recognized by 
MotionView. This issue is resolved.

•	 Points were not being created during CAD/FE model import with interactive HyperMesh option. This 
issue is fixed.

•	 Right click at the bottom of the browser resulted in context menu to appear further away in Linux. 
This issue has been resolved.

•	 Origin field in the Joints panel not appearing with blue background while referring to the Point pair 
attachment is fixed.

•	 An application error while closing “Import is a success” message after clearing the message log is 
fixed.

•	 Problem with *Set statements not being saved to the data file mdl after cut and paste into an 
assembly is resolved.

•	 MotionSolve XML export contained compliant joint markers when joints were set to non-compliant. 
This issue is resolved.

•	 Selection focus in the Project Browser was lost when an entity was deleted. This issue is resolved.

•	 Damping values in the Flexbody panel in Abaqus solver mode were not being populated on loading 
of the model. This issue is fixed.

•	 Direction Cosine of markers were displayed  incorrectly when using “Orient by Angles” option. This 
issue is resolved.

•	 An application error on Export Curve in the Curve panel is fixed.

•	 MotionView crashes when opening a model which does not specify “varname” in *BeginMDL() 
block. This issue is fixed.

•	 Parametric expressions in the Solver String entity field were not being evaluated. This issue is 
resolved.

•	 A problem with references to the left and right side of pair entities in the Attachment Candidates 
dialog is fixed.

•	 SUP file path was not getting populated in Body panel for Abaqus solver mode. This issue is 
resolved.

•	 An error encountered when cutting a Template and pasting into another System or Analysis, is 
fixed.

•	 An application error encountered when exporting data in “Data Summary” dialog, is fixed.

•	 The issue of incomprehensible Messages in message log related to deactivated entities is now fixed.

•	 Project Browser: Find tool or search feature returns blank entries such as in Datasets ID column 
when searching for ‘0’. This issue is resolved.

•	 There was an issue with the Save As dialog on Assembly not appending .mdl extension 
automatically.  This issue is fixed.

•	 Cone’ option for ‘Tangent-Plane’ type in Constraint Mate entity in Advanced Joints was missing. This 
issue is resolved.

•	 Output panel for Action only Force on Body did not gray marker choice and set to I_MARKER. This 
issue is resolved.

•	 Entity Info dialog using note-pin was not refreshing ID field(s) when using ‘Evaluate ID on Apply’ 
option. This is fixed.

•	 Orientation references of marker in an assembly were saved as global reference (e.g. MODEL.body.
cm.xaxis) instead of as a local reference (body.cm.xaxis). This issue is fixed.

•	 Message when a dummy body was introduced upon export at flex body interface node did not 
include the corresponding marker’s parent entity. This issue is fixed.



•	 A problem with ineffective deactivation of the Forms entity is fixed.

•	 Loading a model with assemblies having two instances of an external definition resulted in a crash. 
This issue has been resolved.

•	 An issue related to erroneous setting of isbush datamember for non-compliant joints during cut & 
paste into a system or analysis is fixed.

•	 An error in creating deformable surface due to misinterpretation of node values specified in 
exponential form is resolved.

•	 Warning message appearing due to illegal pair designation for graphic definition is resolved. The 
warning used to appear when MotionView corrects the graphic instantiation using *GraphicPair 
statement instead of *Graphic statement.

•	 The attribute “hold_order” for Control_PlantInput was not being exported to MotionSolve XML. This 
issue has been resolved.

•	 An issue with scroll wheel not working in the Expression builder is resolved.

•	 Saving of mdl file in Linux platform sometimes resulted in creation of a null file. This issue has been 
resolved.

•	 There was an issue with the point collectors for orienting markers not selecting an attachment point 
of the parent system. This issue is now resolved.

•	 A system with an existing definition name being imported in an assembly renames the definition. 
This issue is fixed.

•	 Datamembers such as state and ic_use_trans (Joints entity) in MotionView model were not 
accessible in HyperStudy. This issue has been resolved.

•	 Importing of adm statements with user subroutine having a space between USER and following 
bracket resulted in an incomplete expression. This issue is fixed.

•	 Surface graphics entities were not being exported to MotionSolve. This issue is fixed.

•	 U and V parameters of parametric surface were not exported to MotionSolve. This issue is fixed

•	 Changing the property type on Force entity panel resulted in a change of force type from Action-
Reaction to Action Only. This issue is resolved

•	 The FIM_S selection of the Force Imbalance Method in the Static simulation parameters tab was 
exported as FIM_D. This issue is fixed

•	 CommandSet now supports deactivation and activation of VFORCE/VTORQ and GFORCE elements. 
The deactivation of pair entities, while exporting to ACF file, was ignored. This issue is fixed.

•	 Entity attachment collectors for a system failed to pick entities from the graphic area when a 
default was specified for the attachment. This issue is resolved

•	 The Find Nodes dialog in Body Deformable -> Properties tab were not listing markers from 
compliant joint. This issue is now resolved

•	 Displacement and force outputs of compliant joints (12.0.103 and 12.0.104) were not being 
exported to MotionSolve. This issue is fixed

•	 “Run” toolbar was not visible when a folder with name “run” existed in the model directory. This 
issue is resolved

•	 Nonlinear bushings Displacement outputs were exported to MotionSolve referring to J Float marker. 
In certain scenarios, it resulted in erroneous measurements. This has been corrected. The output is 
now measured between the I and RM markers

•	 Flickering of HyperWorks application was observed when reading curve data with display set with 
small fonts. This issue is resolved.

•	 The Rho (r) property in polybeam now displays value in exponential form



Known Issues

•	 Vehicle Dynamic Tools Auto-Entities cannot be selected from the graphics view for modification.  
You must select the entity in the model browser.

•	 Vehicle Dynamics Tools preference option is not being loaded when invoking other clients and 
then switching to MotionView. It is recommended to invoke MotionView directly to use the Vehicle 
Dynamics tools.

•	 ADM files with expressions having large blank spaces from the beginning of the line leads to 
expressions being truncated.

•	 An increase of memory usage and model opening time is observed with large set of assemblies 
sharing system definition through external files.

•	 “Material inside” information related to box, cylinder and sphere graphics is not saved into the mdl 
file.

•	 Browsing for filename from File fields on Linux and Mac shows full path in the file select dialog 
instead of file name only.

•	 Message related to insertion of dummy bodies for a flexible body is repeated while exporting to 
Adams.

•	 When the origin for the Points collector in the Inertia Coordinates tab of the Body panel is 
unresolved, the CG inertia summary assumes inertia is specified in the global coordinate system.

•	 F1 keyboard shortcut help on Vectors panel leads to an Error page.

12.0.104 Release Notes

Resolved Issues

•	 Loading a model with assemblies having two instances of an external definition results in a crash

12.0.103 Release Notes

Resolved Issues

•	 Incomprehensible messages in the message log related to deactivated entities

•	 Expand/Collapse of HWDesktop windows on Linux and Mac with multiple clients causes blanked or 
non-viewable graphic screen

•	 Application error while exporting data from Data Summary and Topology Summary

•	 New CT reader support for import of UG is added

•	 MotionView does not export ModeLoads contained in flexible body H3D

12.0 Release Notes

New GUI Architecture

MotionView 12.0 comes with an enhanced User interface based on the Python programming language. 
The MotionView Project Browser, Entity ‘Add’ dialogs and panels are affected, though the layout, 
functionalities and user feel remain the same as in version 11.0. With this change, a significant 
improvement in usability and performance is expected.



Project Browser Enhancements

The new Project Browser comes with following enhanced features:

–– Navigation using keyboard arrows and keyboard shortcuts to rename and delete entities.

–– The browser has an additional column that displays variable name of the entity.

–– The content hierarchy is displayed collapsed to the first level when a model is opened

–– Folders are now listed alphabetically

–– Drop-down menu “View All Types” and “View Selected type” no longer exist. Filtering options 
are now available via right-click context menu. Entities can be filtered by entities based on 
entity toolbar selection (“Filter using Toolbar”) or specific entities (e.g. “Show Bodies Only”). 
Filtering also supports multiple entities, e.g. “Show Joints and Points only”.

–– Improved context menu layout

–– Cut’ now works with multi-selections

–– Analyses will be always listed after all Systems/Assemblies

–– Adding entities through context menu in the browser has an extra level

Entity Panels and Toolbar Enhancements

In previous releases of MotionView, all of the panels in the interface had been constructed using TCL. 
With the 12.0 release, we have created a number of Python-based panels that are equivalent to, and 
replacements for, many of the TCL panels. Using the default Python panels, you should experience 
improved panel behavior while still maintaining the same overall ‘look-and-feel’ that you are 
accustomed to. Some of the panel improvements include:

–– Less flickering when switching between panels

–– Faster display of panels when navigating the model through the Project Browser

–– More panel-to-panel consistency (e.g. text labels, widget placement)

–– Wider fields for entering Expressions

–– New logic for some GUI widgets, such as disabled checkboxes, that now replace some alert 
boxes

–– Additionally, many of the entity Add dialogs have also been rebuilt using Python. Add dialogs 
come with keyboard shortcuts on OK, Apply and Cancel buttons.

–– The entity collector in the panel is now replaced with a common entity selection arrow in the 
toolbar. The entity collector in the panel is changed to an icon image with tip text.

Selection Mechanism Changes

The mechanism for selecting model entities from the graphic screen has been updated. The 
MotionView toolbar now has a new Entity Selector button to indicate when you are in Selection mode. 
This button appears depressed when graphical entity selection is allowed and un-depressed when you 
have entered Collection mode. For example, when using a Body Collector on the Marker panel you are 
in Collection mode, so the Entity Selector button will appear un-depressed. To exit Collection mode, 
simply choose an icon in the toolbar via left-click and you are back in Selection mode for the entity 
type represented by the icon you have chosen. Or, you can click the Entity Selector icon.

Tip: Double-clicking the Entity Selector icon is a handy way to clear out any entity icon selection in the 
toolbar; it can also take you out of any active Collection mode.



Another related change is in the behavior of panels while selecting the icons in the toolbar. The toolbar 
now exclusively acts as a filter for selecting entities from the graphic screen. Mere depression of an 
entity does not bring up the panel for the entity of that type that might have been selected previously. 
For example, if a body was selected with its panel displayed and then a different entity was selected, 
clicking on the Body icon again in the toolbar does not display the previously displayed body panel.

Tip: Use the Back/Forward button on the panel to navigate to the previously selected entity panels.

General State Equation Entity

General State Equation (Control_StateEqn in MotionSolve and GSE in Adams) used to model 
a non-linear dynamic system is now supported in MotionView MDL through new statement 
*GeneralStateEquation() .This entity is not yet supported in the GUI. Refer to MotionView MDL 
Reference Guide for more details on this entity.

Messaging Improvement

MotionView message log now provides messages referring to entity labels instead of variable names. 
This option can be controlled in Tools > Options > Check Model.

Changes to MotionSolve XML

From this release, MotionSolve XML exported by MotionView will contain additional modeling 
information such as Model assembly hierarchy and full label for each entity. The assembly hierarchy 
information is available at the initial portion of the XML before the <Model> statement.

The full label for an entity is available above each entity statement.



BasicFEA 12.0.110 Release
Basic FEA now Handles 2D Surface Geometry

•	 Solid to Shell midsurface conversion

•	 Retrieve the original 3D CAD with Shell to Solid

•	 Shell meshing, with optimized quality mesh

•	 Rigid bodies and sliding pins now operate on lines

Contents

Shell Parts

Total Load Display Options

Auto-contact Tolerance Settings

Resolved Issues

12.0 Release Notes

Highlights of the

12.0.110 Release Notes 

Shell Parts

BasicFEA now handles 2D surface geometry.  Users are able to import 2D surface CAD, or midsurface 
their 3D solid CAD with the Solid to Shell tool available from the Parts menu in the BasicFEA browser.  
In order to support surface geometry, we’ve added shell meshing with the option for an optimized 
quality mesh.  We’ve also added support for line selection with our Rigid bodies and Sliding pins.  
Finally, as long as you import 3D solid CAD and use our Shell to Solid tool, we offer the option to 
retrieve the original CAD with the Shell to Solid option.



Total Load Display Options

Under the Loadsteps right click menu, we’ve added a settings option to display the load value in the 
browser:

Show total load will display the total load applied to the selected surfaces, while Show distributed 
load will show the load applied per unit area (pressure).

Auto-contact Tolerance Settings

The Auto-contact tolerance is automatically calculated based on the size of the imported model, but for 
more user control, we’ve exposed it in the right click menu under contacts.



Resolved Issues

•	 Fixed fatigue material conversion issue

•	 Added language updates

12.0 Release Notes 

Basic FEA Accessibility

BasicFEA is now accessible through HyperWorks Desktop.

Split screen for Pre and Post is available while in the BasicFEA environment.

 New Fatigue Loadstep

BasicFEA Materials Database is updated with fatigue material properties.

EN and SN formulations are available.

One or two loadstep events are available

New Meshing Options

Hexa/Tetra Elements

•	 With this option, if the geometry is easily meshed, BasicFEA will produce hexa elements.  If the 
geometry is complex, BasicFEA will default to tetra elements

First/Second Order Elements

•	 This option controls the mesh and the quality of the results.  It can also affect run time.

New Basic FEA Toolbar

BasicFEA process is now captured in the top-down toolbar.

 Translation

Translated into new languages

•	 Korean, Turkish, Chinese (Simplified), and Chinese (Traditional)

 HTML Report

An HTML report is available after a successful run through the View report option in the BasicFEA 
browser right click menu.



HyperMath 12.0.110 Release
•	 Handling of ASCII File

•	 Memory Management

•	 Empty Matrices

Contents

Handling of ASCII File

Memory Management

Empty Matrices

Error Handling

Math Library Enhancements

Resolved Issues

 

12.0.103 Release Notes

12.0 Release Notes

Highlights of the

12.0.110 Release Notes 

Handling of ASCII file

The editor can now read in all ASCII files.

Memory Management

•	 Improvements to the memory management

•	 Memory allocation issues are caught and reported as error messages

•	 Memory is cleared and possible leaks have been tracked

Empty Matrices

A number of the Math functions have been improved to properly handle empty matrices.



Error Handling

•	 Improvements to the error handling and error messages

•	 Handling of error returns within the Eval() function

•	 In conjunction with the empty matrix handling, associated error messages are put in place or 
improved

Math Library Enhancements

•	 Numerous enhancements to equality and comparison tests

•	 Improved support of complex numbers in some functions

Resolved Issues

•	 Slowness of the Dir() command observed on some systems is solved

•	 Wrong Warning messages in batch mode are removed

•	 As a consequence of the deprecation of the local keyword, all scripts where local is used to define a 
variable are initializing those variables to nil

•	 Fixed plotting performance issues on Linux

•	 Fixed display issues related to the Legend on plots

•	 Improved quality and display of curves markers

•	 Fixed the returned value of plot handles when using PlotLine()

•	 Fixed text font and text color issue in the HML command window upon copy/paste actions

•	 Fixed issue with the HyperMath plugin in HyperView Results Math. Multiple HyperMath derived 
results can now be used.

12.0.103 Release Notes 

Resolved Issues

•	 Crash on startup if no license found

•	 Multiple HyperMath based derived results for HyperView leading to crash

•	 Crash during matrix indexing embedded in tables

•	 Performance degradation

12.0 Release Notes 

Statistical Math Library Items

Statistical math library items: Hypothesis tests

Signal Processing Math Library Items

Signal processing math library items: Faster FFT, Bessel filter



Language Items

Language items: Copy on write for matrix data

HyperWorks Integration

HyperWorks Integration: Function registration with HyperGraph directly from the editor

User Interface

User Interface: Split pane editor, combined plots & grids pane



HyperStudy 12.0.110 Release
Next Generation HyperStudy
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Highlights of the

12.0.110 Release Notes 

HyperStudy enables users to explore, understand and improve their system designs using methods such 
as design-of-experiments and optimization. HyperStudy generates intelligent variations of the parameters 
of any system model and reveals relationships between these parameters and the system responses. 
Using HyperStudy, users can make better decisions and optimize the performance, reliability and 
robustness of their systems.

HyperWorks 12.0 introduces an enhanced and updated version of HyperStudy. The new version of 
HyperStudy merges the strengths of the classic HyperStudy along with new simulation technology and an 
improved user experience.

•	 The improved Study Explorer guides you through the study process, following the steps a typical 
engineer goes through to evaluate a design. You are asked to identify inputs and outputs, and then 
specify what you want to learn about the design under investigation, such as optimal values, trade-
off options, or directional guidance.

•	 Entering, monitoring and reviewing data has been simplified through the use of tables. Tables 
provide convenient features such as sorting, cutting and pasting, and filtering to help you 
manipulate and understand your models and results better.

•	 Study sessions are still saved to an .xml file and new in 12.0, the “DataSet” for each approach 
in the study is now stored in a self-contained and open relational database. This storage method 
facilitates faster I/O and more flexible post-processing.

•	 The study directory structure has been updated for consistency and allows for easier automation. 
A directory view of all the files associated with a study is available in the new Directory tab in the 
Study Explorer pane.



•	 The Approximation module has been replaced by a Fit Approach

•	 For experienced HyperStudy users, the transition to 12.0 is seamless, as the overall philosophy of 
the product remains the same.

12.0.110 Release Notes 

Setup: Simplified Study Setup by Auto Fill

In Add Model step, when an unparametrized file is picked as a resource, the filename is automatically 
written as input and the file is opened in the Editor as a .tpl file.

Fit: Enhanced Post-Processing

Trade-off 1D page is enhanced to show the relative change in the responses.

Optimization: Simplified Specifications

•	 Only methods that are applicable to the problem formulation (design variable, objective and 
constraint properties) are displayed.

•	 Method parameters are divided into two as Basic and Advanced Settings. 

Optimization: Enhanced Iteration History Table, Iteration 2D and Iterations Plots

•	 Iteration History indicates the individual constraint violations.  Constraints that are violated are in 
bold font.

•	 Iteration Plot2D Objective plot indicates the infeasible designs. Infeasible designs are marked with 
a larger circle.

•	 Iteration Plot2D has an option to display bounds. When selected, design variable, response and 
constraint bounds are displayed with lines.

•	 Iterations chart in optimization post-processing has a channel selector for the iterations.  Using this 
selector, Pareto Fronts can be displayed.

General Improvements

•	 Setup: MotionView enable combo box when MotionView system has more than one model

•	 Setup: Basic MS/Excel connection now supported on Mac

•	 Optimization: Optimpost is retired and its functionality is replaced with enhanced optimization 
table and plots (see Optimization: Enhanced Iteration History Table, Iteration 2D and Iterations 
Plots list above).

•	 Optimization: Triangular and uniform distributions can now be assigned to random design 
variables and random parameters SORA, SORA_ARSM and SLA methods.

•	 Stochastic: Design variable distributions can be censored by their upper and lower bounds.

•	 General: UFT-8 support is added for Labels, Comments, Notes.

•	 General: Drag and drop of archive files (.hstx file) to an existing HyperStudy application imports 
the archive file.

•	 Help: Help re-writing is complete. The new help contains all new content, including updated 
tutorials and an improved tutorial system.



Resolved Issues

•	 Duplicate labels will fail in the HTML report generator

•	 An excess of 254 variables will not display properly in the run matrix

•	 Issue: [273542] OPT: different ARSM results because of different GUI workflow

•	 Multi model use in conjunction with the Extract tool will not work properly

•	 Issue: [277262] resvector Builder - Time channel in ODB files

•	 With Multi model the Task Manager text updates are not synced with the write/execute/extract

•	 A success may show up but another write needs to be performed

•	 Following tutorial file is not up to date tutorials/hst/HS-4230/plate.tpl

•	 Default graphical difference tool is slow on large files.  The expectation is user uses their own. (see 
tips/reminders)

•	 If testing a win32 installation on a win64 machine the radioss.bat and run_dss.bat files need to be 
modified for OS_BITS

12.0 Release Notes 

Significant UI Redesign

•	 New Welcome Page that allows easy study and quick start examples access

•	 Attributes and Data are presented in tables with rich set of features

•	 Approach steps are simplified and commonized

•	 Restructure of what questions are asked early in the process

•	 New and enhanced Evaluation Form capabilities

•	 New editable run Matrix view

•	 Use of Multiple Threads for the Evaluate form, offering up to seven dynamically updated views

•	 Enhanced Function Expression Builder

•	 Enhanced Message log area

•	 New Directory View

•	 New reporting functionality

General Enhancements and New Features

•	 Directory structure is simplified and commonized

•	 Archive export/import feature

•	 System Bounds Check Approach

•	 Batch mode control of tasks on an Approach by Approach basis

•	 Multi-Execute (Concurrent running of jobs)

•	 Automatic updater from previous release

•	 Any of the Approach Run matrix results can be used to create an Input Matrix and fits can be 
referenced by any of the Approaches now

•	 Model evaluation order and dependency checking enhanced



Extended Post Processing

•	 Consistency between Approaches

•	 More options on how to plot channels

•	 Multi plot

•	 Tight coupling with HyperGraph (Double-click in a chart)

•	 Color Map

•	 3D iteration table

•	 Richer iteration table

•	 Stochastics Reliability plot

New and Improved Methods

•	 Fitting Method: Radial Basis Functions

•	 Reliability-Based Design Optimization Method:Single Loop Approach

•	 Optimization Method: Global Response Surface Method and Hybrid Method for Multi-Objective 
Methods
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12.0 Release Notes

12.0110 Release Notes - Incremental

Common (RADIOSS and LS-DYNA)

•	 Support definition of user defined location to store user defined materials

•	 Support setup of forming process using tailor welded and multilayered blanks in the User Process



•	 Introduction of new option to request animation file as function of tool stroke for each moving tool 
in the User Process

•	 Option to define force as a linear curve added in the User Process

•	 Stroke has been added to the binder for relative positioning of tools in the Auto Process

•	 New user friendly browser introduced to setup process optimization problem and execute through 
HyperStudy

•	 Springback positioner tool introduced to position the springback part relative to the tool/part before 
springback as a precursor for springback comparison and compensation

RADIOSS Only

•	 Gravity setup improved for speed and accuracy

•	 Hydrobending setup added to support tube bending with fluid mandrel

LS-DYNA Only

•	 Support of thermal forming setup for hot stamping simulation

Resolved Issues

•	 Incremental – RADIOSS

–– Saving material with multiple curves in the material database

–– Local coordinate system definition using solid elements

–– Missing self contact definition for the blank in the solver deck

–– Renumbering of nodes in the springback setup after trimming

–– Mesh refinement after gravity in multstage run using fine mesh option

–– Explicit engine keywords in implicit gravity deck

12.0.110 Release Notes - Die Module

Resolved Issues

•	 Trim line extraction for part with symmetric boundary conditions

•	 Improper trim line definition while adding and removing ribs

12.0.110 Release Notes - RADIOSS One Step

Enhancements

•	 New user friendly browser introduced to setup process optimization problem and execute through 
HyperStudy

•	 Export of flattened blank geometry in STEP format

Resolved Issues

•	 Duplicate curves created when importing FLC curve



12.0.110 Release Notes - Blank Nesting

Enhancements

•	 Support for costing in blank nesting

12.0.110 Release Notes - Post-processing (HyperView)

New Features/ Enhancements

•	 Line tracing tool improved for accurate blank shape and trim line prediction/tracing

Resolved Issues

•	 Tool-blank macro fails to calculate the distance and results in distorted mesh

12.0 Release Notes - Incremental

Common (RADIOSS and LS-DYNA)

•	 Support for multi-stage processes to run in batch mode to leverage servers and clusters

•	 Support definition of user defined location to store user process setup in the HyperForm 
Preferences.

•	 Support of Datum, the reference object used for relative positioning of all other objects.

•	 Option to store objects position in space as Home position for every tool and ability to return back 
to home position after autopositioning.

•	 Performance of springback comparison tool significantly improved

•	 Ability to pick material created in the session without storing in material database.

RADIOSS Only

•	 Trimming of solid element blanks

•	 Seamless integration with HyperStudy for process optimization (available on windows platform)

•	 Improvement of GAP option under Auto Process for better correlation with physical data

•	 Support of new materials for thermal forming with solid elements. Also database populated with 
Boron steel and Magnesium materials

•	 Support of new materials for forming with solid elements.

•	 Support of seamless springback option in user process with Automatic option

Resolved Issues

•	 Incremental – RADIOSS

–– Drawbeads created using blank from STA file resulting in solver error in starter because of ID 
overlap

–– Time step calculation for Fast (Fine mesh) setup not working for Yoshida Material and Thermal 
using shell elements



–– STA file reading resulting in solver error during starter run.

–– Tool and blank temperature not saved in .hf file

•	 Incremental - LS-DYNA

–– Error in *CONTROL_IMPLICT_SOLUTION with the variable LSTOL value.

–– Error while defining constraints for springback setup.

–– Error while creating input deck for trimming operation

12.0 Release Notes - Die Module

Enhancements

•	 New binder creation by extension of the part·

•	 Addendum creation supported with option to consider ribs at corner      

•	 Automatic calculation of offset based on thickness and offset value for punch and blank holder 
creation.

•	 Organize option under the User Process to consolidate part, addendum and binder to one 
component to simplify Incremental setup.

•	 Improvements in the double attach option

•	 Drawbar creation for complex lines.

Resolved Issues

•	 Automatic update of drawbar and drawbead after binder edit.

•	 Delete part does not remove all children entities.

•	 Punch Opening Line could not be created for symmetric models.

•	 Existing addendum not masked/deleted when new addendum is created.

12.0 Release Notes - RADIOSS One Step

Enhancements

•	 Seamless integration with HyperStudy for blank size optimization (available on Windows platform)

Resolved Issues

•	 Duplicate curves created when importing FLC curve

12.0 Release Notes - Blank Nesting

Enhancements

•	 New option to reflect about X and Y axis to create duplicates

•	 Option to auto nest by translations of parts around each other

•	 Option to auto nest by rotation of parts relative to the sheet/ Coil

•	 Creation of HTML report from the blank nesting tool



12.0 Release Notes - Post-Processing (HyperView)

Enhancements

•	 Customized drop down menu for HyperForm including all stamping related features

•	 Section Cut to plot variation of results along cross-sections

•	 Draw-in plot to measure movement of blank boundary

•	 Blank-Tool gap plot to visualize final blank position with respect to the tools



HyperXtrude 12.0.110 Release
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HyperXtrude/Metal Extrusion

Specifying Billet Taper Data

Billets are often heated with temperatures varying axially from the dummy block end to the die end. 
This is called Axial Taper. Similarly, Radial Taper and Lateral Taper heating is also used. Using the 
new Billet Taper macro, you can specify all these three types of tapers in the analysis.

•	 Axial taper specification can have up to five zones and temperature can vary linearly in each 
zone with different gradients.

•	 You can specify lateral taper and radial taper in the model. These do not vary by zones.

This data is required only for transient analysis. 

Starter Billet

Using the Billet Taper macro, you can specify starter billets of different lengths and use different ram 
speeds for each billet.  This data is relevant only for transient, multi-cycle analysis.  You can specify 
up to 5 different initial cycles with varying billet length data.  In addition, you can use different axial 
tapers for each of the initial cycles. Data specified for the last initial cycle will be used for the rest of 
the analysis. 

Super Alloy Extrusion Using Glass Lubrication

The Extrusion Wizard now supports glass lubricated (with glass pad and glass powder coating) 
extrusion. This is often used with nickel, titanium, and steel alloy extrusion. Previously released 
versions of the HyperXtrude solver does not support the analysis of these extrusions and requires a 
custom version of the solver to be installed. 

Glass Pad Material Model

The user interface now supports a new material type, Glass Pad. This material data can use either 
polynomial or VFT constitutive laws. In addition, the interface can fit the coefficients for VFT model 
directly from the composition of the glass.  In material database, there is another material type called 
Glass Properties; this is provided for backward compatibility and will be removed in 13.0. 

Mandrel Offset

While meshing the models with die mandrel, it is recommended to mesh a flushed model; that is, with 
no offset in the mandrel. This will result in mesh with good quality elements in this region. However, in 
this release you can mesh the model with the offset. If the offset is included, then you should specify 
the length of the Mandrel Offset in the bearing BC data. This will enable the solver to account for 
this in bearing friction computations.  Due to this change, data exported in 12.0.110 will require the 
12.0.210 solver. This selection is enabled in the Export panel.

Resolved Issues

The following critical bugs in the HX Job Manager are resolved:

•	 Issues related to automatically creating password free connection are resolved.

•	 Putty and Gzip locations can folder name with spaces. This will enable the user to install them 
in “Progam Files” folder.

•	 While setting up clients, user can pick BAT files instead of executables.



The following issues were resolved in the Tube Extrusion Wizard:

•	 Unsupported unit systems are disabled

•	 Errors in geometry creation are resolved

•	 Errors in specifying correct friction conditions are resolved

•	 Time step is computed correctly even if user does not use the variable time step option

Other resolved issues:

•	 Resolved errors in estimating billet diameter in Parameters panel; now Billet-Container BC is 
used to estimate this value.

•	 Sometimes the user specified mesh in “my_2D_Bearing” is deleted if tet mesher fails. This issue 
is now resolved.

HyperXtrude for Polymer Processing

Tire Extrusion Wizard

A new model setup wizard to simulate extrusion of tire treads is implemented.

•	 This wizard can either create the geometry based on given data or use the user specified solids 
for each component.

•	 In this release, the extruder type multi-cut is supported

•	 You can specify the tread/die contours either as symmetric or full contours

•	 Specified contours can be stored and reused

•	 This module also comes with a report generator

Improve Mesh by Remeshing

All the wizards under Polymer Processing now have the Improve Mesh option. This improves the 
quality of the mesh generated by remeshing the solids based on the initially generated mesh.

Tool Deflection Analysis Wizard

This model setup wizard allows you to solve tool deflection analysis using OptiStruct.

•	 It automatically meshes using linear or higher order tets

•	 Supports pressure or force load boundary conditions

•	 You can map the loads from HX analysis

•	 You can model contact conditions in the model

•	 You can specify the temperature condition for each component and also specify appropriate 
constraints on boundary faces

Resolved Issues

Some critical issues in the Polymer Melt Flow Analysis Wizard are resolved. Now the inlet and outlet 
can have any axial orientation, however, you should use tet mesh or solid map in this region (drag will 
not work and will require orientation along Z axis). In addition, issues in organizing the exit BCs  are 
now resolved. 



12.0.101 Release Notes

New Features and Enhancements

All the model setup wizards in the HyperXtrude sub-profiles have been enhanced with a re-meshing 
utility that greatly improves the quality of the generated mesh.

Resolved Issues

Some critical GUI and configuration related issues in the HX Job Manager have been resolved.

12.0 Release Notes - All Profiles

HW Desktop

HyperXtrude user profiles are now available from HW Desktop. This will enable user to view both the 
pre-processing (HM) and the results (HV) from the same window.

HX Import

Importing HX data deck using the green arrow button is available and it can be invoked from the 
standard toolbar of HyperMesh.

HyperXtrude Export

Interface is enhanced to set advanced parameters for using multiple CPUs/cores in a shared memory 
computer.

Resolved Issues

•	 If an HM model was imported using feinput, project browser was not recognizing the CAD data. 
This issue is fixed. Now the browser will accept HM file imported as well as loaded in the standard 
way.

•	 Bug fixes to address issues arising from error in the project root, file write permissions, etc. are 
implemented.

12.0 Release Notes - Metal Extrusion

Tool Deflection Analysis

This wizard will guide the user to perform tool deformation analysis using RADIOSS solver.  It has the 
following features:

•	 Step by step guide to do the analysis starting with solids

•	 Support for Pressure/Force loads

•	 Support for Contact BCs

•	 Support to do analysis using assumed loads

•	 Support to do analysis with loads computed by HX solver, by mapping the results on the tool 
mesh



•	 Higher order elements are now supported by the wizard. Accuracy of the results computed by 
RADIOSS solver increases when second order elements are used.

In addition this tool requires no prior knowledge of RADIOSS solver or its native interface to perform 
the analysis.

Bearing Optimization

Create/Edit BC macro now provides an interface to do bearing optimization with HX solver. This is a 
direct and faster approach and does not require HyperStudy. This approach groups the bearing control 
points into design, fixed, and dependent points. By adjusting the design points based on the material 
flow dynamics, it balances the material flow. 

Tube Extrusion Wizard

This wizard will setup model for extrusion of metal tubes using glass coated conical die or a flat die 
with a glass pad. This setup does not need CAD geometry and it will automatically create the geometry 
and the mesh.

Hensel Spittel Material Model

User interface for Hensel-Spittel material is added. This will allow to users to create and assign 
materials with this constitutive model to element components.

HX Job Manager

HX Job Manager is now part of HyperWorks. Until the previous release it was a standalone product that 
was downloaded separately. HX Job Manager is used launch HX and RADIOSS solver runs. These runs 
can be launched on local Windows machines, remote Windows/Linux machines, and on PBS servers. 

Tool Temperature Data

This data is used to specify the temperature of the tool. Interface will write this data in the GRF file 
based on the specified container and die data. If there are other tool components in the model, you 
have to manually edit the GRF file and modify this data. This is data is relevant only for transient 
analysis. 

Glass Properties

Glass Properties is used to model glass pads used in super alloy extrusion. It is available now from 
material database window.

Interior Surface BCs

These BCs are used for diagnostic purposes to better understand the material flow in a multi-hole die, 
as the solver will print the mass and heat flux through these faces. Extrusion Wizard will automatically 
capture interior faces between two workpiece components having same material and mark them as 
interior surface boundaries. 

Friction Models

BC editor is enabled to support all friction models.



Resolved Issues

•	 Bugs in determining the bearing starting point have been fixed. Now the macro will ignore the 3D 
mesh and use only the solids in the model to determine the bearing starting position. In addition, 
user can modify the detected starting point.

•	 When importing existing data decks, HX will read the parameter file and update the Extrusion 
Wizard and Process Parameters cards. This fix includes improvements to bearing profile import.

•	 Tube Extrusion Wizard:

–– Few meshing related bug fixes were implemented.  Tolerances used are made unit dependent 
to resolve meshing issues.  In addition, additional checks are implemented to verify the 
dependency in meshing parameters.

–– For rod extrusion, there is no mandrel and hence no mandrel BCs.  Application error related to 
this is issue is fixed

–– Data checks to validate the geometry data are implemented

–– Separated Mesh and BC creation process steps in Tube Extrusion Wizard for better control

–– Redesigned Model/Process information GUI in Tube Extrusion Wizard

•	 BC check for undefined boundary faces assumed that for every load collector there will be a 
corresponding collector with BC faces and the vice versa. This was throwing an error if user had 
accidentally deleted one of them. This is issue is fixed. In addition, when the new BCs for undefined 
faces are created – they are created with correct conditions and the user will be not be able export 
a model that contains BCs created by “check undefined BC”. User will have to inspect and rename 
this BC to export the model.

•	 Checks to ensure billet length specified is greater than butt length is not relevant to steady state 
analysis. This data check is streamlined now and the underlying errors in the default values (unit 
dependency) are corrected.

•	 Bug fixes to control point selection panel. Even if user selects points that are not part of the 
bearing profile, they will be automatically rejected.

•	 Interface will support only the standard indirect extrusion, where the dummy block and container 
move along the extrusion axis. Indirect extrusion with moving die will be supported in the next 
release.

•	 Symmetry faces on tool elements are now organized into separate components to overcome errors 
in detecting undefined boundary faces.

12.0 Release Notes - Polymer Processing

Meshing Wizards

All the model setup wizards in “Polymer Processing” are enhanced to efficiently select the components 
and boundary faces.  In addition, all wizards derive their specific versions form this common 
framework and hence, provides a similar look and feel. 

Plate Meshing Wizard

Upgrades to this wizard include:

•	 Computation of exit velocity and extrusion ratio

•	 Starting the wizard from an existing mesh

•	 Support for including the tool in the model



Coextrusion Wizard

A new wizard is implemented to guide user systematically starting from a CAD model to setup 
coextrusion models with inserts.

•	 It will compute and show the exit velocity and extrusion ratio for each material layer.

•	 It supports starting the model from an existing mesh

•	 It supports meshing and BC creation for Tool

Runner Balancing Wizard

The Runner Balancing Wizard implemented in this release is used to create mesh for injection molding 
runner balancing analysis.  This tool creates high quality meshes and can handle complex runner 
systems.

Melt Flow Analysis

A wizard to guide the model setup of polymer melt flow (or a non-Newtonian fluid) in any three 
dimensional conduit is implemented.

Viscoelastic Material Model

Material Database now supports Criminale—Ericksen—Filbey viscoelastic material model.

Project Browser

Enabled Project Browser to manage projects and runs for Plate Meshing, Coextrusion and Melt Flow 
Analysis wizards.

Symmetry BC

Polymer meshing wizards now provide an option to create symmetry boundary conditions. It is 
supported even for models that start from an existing mesh.

Interior Surface BCs

Plate Meshing, Coextrusion and Melt Flow Analysis wizards captures Interior Surface BCs between two 
Polymer components having same material. 

Resolved Issues

•	 Fixes to unit conversion errors when specifying melt flow rate in non-standard units (such as, mm/
min, cm/min, m/min, etc.).

•	 When the model has insert, interface will automatically write the tool velocity data packet. This 
data is expected by the solver.

•	 Exits and FreeSurface BCs are organized based on XY values in Plate Meshing, Coextrusion and 
Melt Flow Analysis Wizards.



12.0 Release Notes - HX-Forge

HX-Forge Profile

The Forging user profile now supports two solvers: Deform and HX-Forge. Latter is a new solver 
targeted for billet forging applications.

Forging Wizard

A new wizard is implemented to guide user step by step to create model data. In this release, this 
wizard will create model for “round-to-round” and “square-to-square” billet forging analysis.

Utility Macros

New utility macros are added for creating tool sets and process builder in order to set up forging 
model. With these tools, user can manually create and setup models for analysis. 



HyperMold 12.0.110 Release
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Moldflow

Solid Meshing Wizard

You can now remesh the model inside the wizard. This feature will not allow selective remeshing and 
mesh all the solids selected for meshing by the wizard. 



Resolved Issues

•	 All solid elements created by the wizard will be split and converted to linear tetrahedral elements. 
Moldflow supports only linear tetrahedral elements.

•	 Performance of 2D surface meshing has been improved. 

Moldex3D Solid

Solid Meshing Wizard

You can now remesh the model inside the wizard. This feature will not allow selective remeshing and 
mesh all the solids selected for meshing by the wizard. 

Resolved Issues

•	 Diagnostics does not support hexahedral elements. If model had hexahedral elements, it was 
throwing application error and it is resolved now.

•	 Few issues were causing the graphics area to freeze and they have been resolved. 

Moldex3D Shell

Importing Data Decks

This feature has been enhanced to include the BC data in import. 

Resolved Issues

•	 User can now select the export folder location

•	 Few issues in midplane wizard have been resolved. These include:

–– Graphics area freezing while creating property cards

–– HyperMesh hanging while creating feed system with trapezoidal cross-section

–– Some popup application errors while assigning thickness, etc.

–– Errors in redesigning feed system

HyperMold - HX/RTM

Pressure Data in Table Format

You can specify the gate pressure a time dependent function in a table format. The GUI supports both 
constant value and table specification. 

Permeability Data in Local Coordinate System

Permeability tensor can be specified in using local coordinate system Interface supports Cartesian, 
Cylindrical, and Spherical coordinate system. HX-RTM 12.0.210 supports only Cartesian and Cylindrical 
coordinate systems. 



12.0.101 Release Notes

New Features and Enhancements

•	 Calculators to estimate maximum injection pressure and time step size are implemented.

•	 Utility panel now includes the Solid Meshing Wizard macro and Split Prism to Tets macros. 

Resolved Issues

Many material data related issues have been resolved; these include local coordinate system for 
perform, viscosity models for resin, and air density calculations.

12.0 Release Notes - General

Menu Panels

Menu panels of sub-profiles are redesigned to include all the essential panel buttons. 

Edge Based Mesh Density Control

A powerful automatic 2D meshing technology to mesh a set of surfaces has been implemented. This 
method automatically adjusts the density of the created 2D mesh on all edges based on a set of 
built in automation rules. This edge based surface mesh algorithm improves the mesh quality of the 
surfaces. This algorithm is implemented in all HyperMold automatic surface mesh macros like Flow3D, 
Moldex3D Wizards, etc.

12.0 Release Notes - Mold Flow User Profiles

Fusion Mesh Ratio

Mesh match ratio of fusion models using a new algorithm is now computed using a C++ DLL. This new 
algorithm is more accurate and agrees well (within 10%) of Moldflow’s estimate. In addition, it is very 
fast – it can estimate for quarter million element model in less than a minute, which is more than 100 
times faster than old approach. 

Flow3D Wizard

Enhancements to improve meshing accuracy.

Built-in access to Feed system wizard.

Feed System Wizard

To design feed system in minutes using a simple step by step approach.

Feed system is now rendered using solids instead of surfaces and also faster than before. This will help 
the user to transition to a 3D runner system from a 1D system.

Solid Meshing Wizard

This wizard is used to generate a 3D mesh in a selected set of solids in easy steps. User can select the 
meshing method for each solid: solid map, tetra mesh or CFD boundary layer mesh. In addition, the 
wizard automatically computes the default element size and the shared surfaces between the solids 
can be meshed without a boundary layer. 



Create Feed System Enhancements

Feed system macro is enabled to create solids for curved feed lines.

Extract Centerline from Feed Solids

A new macro to  extract the centerline from feed system solids has been implemented. This axis can 
be used as a feed line in feed system creation.

Macro for Property Card Assignment

This macro assigns the existing Moldflow property card to the selected elements. 

Resolved Issues

•	 Assign Thickness: Thickness extraction was not working correctly when multiple surfaces were 
selected.

•	 Feed System: Error in creating tapered feed lines is fixed.

•	 Feed System Wizard: Enhanced to automatically proceed to the next step in the wizard.

•	 Flow3D Mesh Wizard: Enhanced to handle the latest CFD mesh options.

•	 CFD Mesh: Naming the collector containing the CFD Mesh collector name is now derived from the 
original component name and the solid ID.

•	 Occurrence Number: Error in plotting the occurrence number plotting is fixed.

12.0 Release Notes - Moldex3D Solid User Profile

MFE Import

Import is made more comprehensive by including all the relevant property cards and boundary 
conditions. Import is also now speeded-up by removing the bottlenecks in the process.

Solid Meshing Wizard

This wizard is used to generate a 3D mesh in a selected set of solids in easy steps. User can select the 
meshing method for each solid: solid map, tetra mesh or CFD boundary layer mesh. In addition, the 
wizard automatically computes the default element size and the shared surfaces between the solids 
can be meshed without a boundary layer. 

Resolved Issues

Feed/Coolant Channel: Fixed the application error occurred while finding element connectivity for 
Feed/Coolant channel elements.

12.0 Release Notes - Moldex3D Shell User Profile

A New Sub-profile

This sub-profile comes with macros to create, setup, an export models for Moldex3D/Shell.



Thickness Extraction

Users can extract thickness from the midsurface and automatically create property cards for cavity 
elements.

Runner Design

Macros to create and setup runner design are available in the interface. This includes surface rendering 
of runner geometry for visualization. Runner system is created on lines with 1-D beam elements.

Extract Centerline from Feed Solids

A new macro to extract the centerline from feed system solids has been implemented. This axis can be 
used as a feed line in feed system creation.

Create Feed System Enhancements

Feed system macro is enabled to create solids for curved feed lines.

Cooling Circuit

Macros to create and setup cooling channels are available in the interface. This includes surface 
rendering of channel geometry for visualization. Cooling channels are created on lines with 1-D beam 
elements.

MSH Import

Existing Moldex3D Shell data decks can be imported into the user profile.

Symmetry BC

Support to specify symmetry nodes has been implemented.

Resolved Issues

Export: Fixed exporting issues from Midplane Wizard.

12.0 Release Notes - RTM User Profile

Data Import

Existing RTM data decks can be imported back into HyperMesh. This release provides a limited support 
for these imports and the main goal is to import the 3D elements and the boundary faces. 

Resolved Issues

•	 Material Database: Added the missing material parameters for preform: density and 
compressibility.

•	 Parameter: Automatically writing “ReservedMemorySize”, which is a required data.



Aerospace User Profile 12.0.110 Release
A new Aerospace user profile was added in the 12.0.110 release.  This profile is aimed to help to capture 
the aerospace model building process and tools necessary for process automation.

Highlights of the

12.0.110 Release Notes

Major Functions

•	 Element C1, C2, C3 direction:  This to display 2D and 3D element local direction

•	 Free Body:  This is to calculate Grid point force contribution to  group of elements from the 
surrounding elements and break out modeling

•	 Map Forces and Mass:  From an Excel or CVS file users can define nodal forces and mass and 
import into HyperMesh and automatically apply to existing model

•	 Matrix Browser:  This new tool will help users to interrogate HyperMesh and HyperView data 
existing in the databases and export to Excel format for further calculations

•	 PCOMP from CSV:  This is aimed to automate creation of large amount of PCOMP properties already 
defined in Excel or CSV file

•	 PCOMP to ply conversion:  This utility converts zone-based models from Nastran to Optistruct ply-
based models

•	 Spatial Renumbering Elements/Nodes: This utility enables renumbering of nodes and elements in a 
predefined system directions for a regular structured mesh

•	 Resequence  Nodes:  This tool reorder the nodes in elements to achieve  consistent C1 direction for 
a group of elements

•	 Shell to Solid conversion:  This function converts shell composite elements into solid composite 
element for each ply layer

•	 Sewing tool:  This connects a coarse Fe model to a Fine FE model using special RBE3 elements 
commonly used in Aerospace industry



CFD User Profile 12.0.110 Release
A new Aerospace user profile was added in the 12.0.110 release.  This profile is aimed to help to capture 
the aerospace model building process and tools necessary for process automation.

Highlights of the
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12.0 Release Notes

12.0.110 Release Notes

Boundary Layer Generation for Baffles and Sharp Edges

New option in the CFD tetramesh panel to control the boundary layer (BL) growth on the free edge of 
a baffle or for sharp edges pointing into the volume. For the free edge of a baffle, two normals can be 
used to grow the BL, resulting in a continuous BL around the free edge. For sharp edges a threshold 
can be defined, to decide whether two normals or one normal is used at the sharp edge to grow the 
BL.



Boundary Mesh Check for Tetrameshing

The Check 2D Mesh utility located on the Tetramesh and CFD Tetramesh panel can be used to 
validate the input surface mesh for volume meshing. Currently checks for intersection and dihedral 
angle (sharp edges) can be performed.

2D BL Meshing

Multiple options for default boundary selection in the 2D BL Meshing utility.

Export Performance of AcuSolve Mesh Format

The performance for exporting in AcuSolve format has been significantly improved, up to three times 
faster. It is a direct export now, meaning no intermediate Nastran file is generated.

Create Exterior Shells During AcuSolve Export

If no boundary shells are generated to define the boundary regions, default exterior shells can 
generated during the mesh export in AcuSolve format. This is an optional behavior and can be 
activated on the export tab for the AcuSolve export. Those elements will also be placed in a new 
component in the HM model. 

Interface Shell Generation During AcuSolve Export

New option in the AcuSolve export tab to generate always two layers of interface shells between two 
adjacent volume zones. 

Surface Mesh Export for AcuSolve

The export interface for AcuSolve is now capable to export a surface mesh in native *.arm format.

AcuSolve Exported File Format

Variable text field length for IDs to reduce memory consumption of *.crd, *.cnn and *.ebc files. Double 
precision for *.crd file.

Constrain for Boundary Layer

A new constrain to preserve the boundary layer thickness and layer distribution during morphing 
has been implemented. This ensures an unchanged y+ (1st layer thickness) while morphing. The 
performance of this constrain has been optimized to deal with thick boundary layers, allowing quick 
design changes.

Large Model Morphing

CFD models are often characterized by a large volume element count. The new option “skin only” 
offers a two step approach for morphing those types of models in an efficient manner. In a first step, 
the user morphs only the boundaries of the flow domain interactively and the volume elements stay 
unchanged. When a new design has been found, the volume elements will be morphed in a second 
step in batch mode.



Morphing Performance

The morphing performance has been further improved by streamlining the existing code and by 
leveraging multi-threading technology. Those enhancements will be beneficial for large CFD models.

Enhanced AcuSolve Case Setup

The AcuSolve case setup has been substantially enhanced, e.g. thermal aspect, transient, turbulence 
modeling.

Fluent Mesh Import Containing Polyhedrals

Loading a Fluent mesh file (*.cas/*.msh) which contains polyhedral elements, will import all the 
standard elements (e.g. hexa, tetra) whereas the polyhedral elements will be ignored. Optional faces 
can be generated on the ignored polyhedral elements during import, so that tetra elements can be 
generated manually in this void region.

Duplicate Check for Export

A duplicate check for Nastran(Fluent), Nastran(PowerFlow) and Nastran (StarCD) export has been 
implemented.

Resolved Issues

•	 Refinement box: T-connections and feature edges included in a refinement box for tetra meshing 
will be remeshed according to the user defined element size for this refinement box.

•	 CFD tetrameshing for baffles: Baffle shell elements are not duplicated when selected as “with BL 
(float)”

•	 Renumbering during export: The node and element IDs are not renumbered during the AcuSolve 
mesh export.

•	 Import/export issues: Improved the SC/Tetra, Fluent and OpenFoam import and export.

•	 CFD tetramesh: Further improved the mesh quality and robustness for CFD tetra meshing as well 
as several bug fixes.

•	 Update of input shells: The input shells are updated when BL only option is used in the CFD 
tetramesh panel for a mix of fluid (with BL) and solid volumes (w/o BL).

•	 Separate component for solid mesh: In the CFD tetra mesh panel, when using “simple select” and 
uncheck “comp per volume”, the solid mesh is placed in a separate component.

HyperView New Features

AcuSolve result reader: A result reader to import native AcuSolve results into HyperView has been 
implemented. Results of steady state, transient and moving/deforming mesh analyses are supported.

12.0 Release Notes

Auto Collision Detection for Boundary Layer Growth

The boundary layer (BL) reduction step is now included into the BL generation routine. During 
boundary layer generation a collision check is performed and the boundary layer thickness is adjusted 
dynamically.



Advanced Parameters for Boundary Layer Generation

Three new options to control the boundary layer growth mechanism have been introduced, including a 
quality focused and a meshing time focused set of predefined parameters. Selecting the user defined 
option will give access to several boundary layer parameters which can be adjusted individually for 
each application.



NVH 12.0.110 Release
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Support for Units in NVH Utilities
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Introduction

To ensure successful adoption by customers, starting from 12.0,  some of the high productivity NVH 
features will be packaged with additional services and made available through the NVH Solution of the 
Packaged Solution Offerings (PSO), and will not appear in the standard HyperWorks without a PSO license 
feature.

1.	 Standard HyperWorks Package

•	 Meshing

–– Cavity Mesher

–– Coarse Mesher

•	 Loadcase setup process managers in generic HyperMesh mode

•	 All RADIOSS solver NVH functionalities

•	 Post-processing utilities (all but ‘Integrated Diagnostics’)

–– Modal/panel Participation

–– Grid Participation

–– Energy Distribution

–– Transfer Path Analysis

–– Design Sensitivity Analysis

–– Order Analysis

 

2.	 Packaged Solution Offerings (PSO) Package

•	 All standard HyperWorks NVH features

•	 HyperMesh - NVH user profile under ‘Engineering Solutions’

–– Assembly Browser

–– Network View

–– Analysis Manager

–– Job Manager

–– Loadcase Setup Process Managers in NVH User Profile Mode

•	 HyperView/HyperGraph - Integrated Diagnostics utility

12.0.110 Release Notes 

CDS SE Creation Process Manager

A new frequency response process manager for guided creation of CDS SE

Access to Job Manager in NVH Utilities

Added icon to invoke Job Manager and quick access to analysis results



Support for Units in NVH Utilities

Provide capability to show units information in axis labels

Enhanced Random Frequency Response Process Manager

•	 Support for PSDF flag for PSD output requests

•	 Support for grid and element set based PSD requests

Enhanced General Frequency Response Process Manager

•	 Support for data in universal format for loadcase creation

•	 Support for modal participation response type selection

•	 Support for for rigid element set for AutoTPA diagnostic output

•	 Support for two step TPA

Enhanced Transfer Path Analysis Utility

•	 Support for matching file

•	 Support for reversing TF and force direction

•	 Support for test based transfer function and force data in universal format

Enhanced Integrated Diagnostics Utility

Support for test based response data in universal format

12.0.110 - NVH Packaged Solution Offering

HyperWorks 12.0 extends the offer for manufacturing and engineering solutions, with new functionalities 
and an innovative delivery model to better capture knowledge for vertical processes.

HyperWorks engineering solutions are now offered as packaged solution offerings (PSO),  specialized 
packages of software and services that support the implementation and utilization of Altair’s solutions and 
technologies, tailored to meet customers’ specific requirements.

To ensure successful adoption by customers, starting from 12.0, some of the high productivity NVH 
features will be packaged with additional services through the NVH Solution of the Packaged Solutione 
Offerings (PSO). Please contact an Altair representative to learn more about the available the Packaged 
Solution Offering and how to use it with your current HyperWorks licenses

Altair PSO for automotive NVH (noise, vibration and harshness) simulation includes:

Software

1.	 HyperMesh - NVH user profile under ‘Engineering Solutions’

a.	 Assembly browser

b.	 Network view

c.	 Analysis manager



d.	 Job manager

e.	 Loadcase setup process managers in NVH user profile mode

2.	 HyperView/HyperGraph - Integrated Diagnostics utility

Training

1.	 Quick start video

2.	 Instructor-led class

3.	 Tailored course

4.	 On-site expert help

 

Customization

1.	 Generic

2.	 Special request

 

Project Engagement

1.	 Engage Altair ProductDesign NVH experts to execute a customer project

Automated Module Preparation

Provides capabilities for ID management and plotel display model creation

Automated Generation of Model Checkout Runs

A new dialog to generate jobs for model checkout runs of multiple modules

Automated CMS SE Generation

A new dialog to generate jobs for creating CMS SE of multiple modules

Automated CDS SE Generation

A new dialog to generate jobs for creating CDS SE of multiple modules

User Message Window

•	 Provide user oriented messages related to execution of user commands

•	 Configurable message output

Macros Dialog

Provide capabilities to access macros packaged with the NVH solution and manage macros added by 
the user



CDS SE Creation Process Manager

A new frequency response process manager for guided creation of CDS SE

Composite Response Creation Tab

Provide capability to create new response points based on existing tagpoints

New Modeling Entities

Provides capabilities to define standard Response, Frequencies, Tire Patch Points for automated 
loadcase setup

Enhanced Module and Connection Browser Tabs

•	 Provide capability to open multiple instances of the Module and Connection Browser Tabs

•	 Tabs can be floating as well as docked

Enhanced Tagpoint Related Functionalities

•	 Improved usability of the tagpoint tab

•	 Enhanced tagpoint conflict resolution during XML import

•	 Tagpoint creation using standard names from a csv file

Enhanced Analysis Manager

•	 Provide capability to overide representation file path required on a remote server

•	 Export all bulk data to the master include file

•	 Mapping files related to Module ID, connection, and tagpoint generated during job creation are 
moved to the output job folder

Enhanced LCS Manager and LCS Creation GUI

•	 Improved usability of the LCS manager

•	 Provide capability to create new LCS entities based on data from existing LCS

Enhanced Connection Mapping Tool

•	 Export connection property to isolator file

•	 Support for PBUSHT properties for import and export

Enhanced Lumped Parameter (LP) Representation ID Handling

LP representations are organized into the ID range assigned to the module, instead of that of the root 
module



Enhanced ID Manager

Capability to import and export module hierarchy and representation include file information in the 
module ID CSV file

Enhanced Network View

•	 Capability to automatically expand connections between two modules

•	 Enhanced entity information in message bar with mouse hover

12.0.101 Release Notes 

Resolved Issues

•	 Improved performance and resolved data consistency issues in reading matrix output in .h3d file.

•	 Resolved an issue related to the Transfer Path Analysis utility when solver response is not available 
in the force file.

•	 Improved performance in importing assembly .xml file

12.0 Release Notes 

Enhanced Unit Input and Random Frequency Response Process Managers

Support for user defined subcases involving multiple inputs 

Enhanced General Frequency Response Process Manager

•	 Support for multiple user defined subcases

•	 Support for diagnostic output at ofreq frequencies 

New Energy Distribution Utility

•	 Visualize vehicle system energy distribution by proper comparator groups in the assembly

•	 Capability to create comparator groups using assembly information from job files created using the 
Analysis Manager

•	 Supports energy output for finite elements, as well as system and component modes

Enhanced Transfer Path Analysis Utility

•	 Support for the new RADIOSS AutoTPA (one-step TPA) output in H3D file

•	 Support for multiple control volumes

•	 Support for multiple subcases

•	 Support for Spindle Loads (simultaneous multiple principal vector subcases)

•	 Support for Engine Loads (simultaneous multiple RPM subcases)

•	 Support for assumed forces



Enhanced Modal/panel Participation Utility

•	 Support for the new RADIOSS component modal participation output in H3D file

•	 Support for associating a normal modes animation file as diagnostic results

Enhanced Design Sensitivity Analysis Utility

•	 Support for ranking design variables by ‘Magnitude sensitivity’

•	 Enhanced design variable labels using assembly information

•	 Support for output generated using the new RADIOSS DSA request in H3D file

12.0 Release Notes - NVH PSO Solution

New Assembly Network View (PSO only)

•	 An alternative way to work with modules and connections in assembly

•	 Best for reviewing assembly topology and connectivity

New Job Manager (PSO only)

•	 Provide a list of all jobs created as a part of a project

•	 Provide a record of why each job was run and how the model was setup

•	 Provides easily access to result file generated in each job 

New Connection Property State Mapping Capability (PSO only)

•	 Connector property state linked to entries in CSV file thru import

•	 Common rate definitions for multiple connections

•	 Connection CSV import/export capability enabling automatic connection update and re-creation

Enhanced Analysis Manager (PSO only)

•	 Capability to create jobs and associate package of files for traceability and post-processing 
purposes

•	 Capability to submit jobs to user specified solvers

Enhanced Tagpoint Mapping Capability (PSO only)

•	 Identify nodes from different modules based on proximity as candidate for module and connection 
creation

•	 Import and export tagpoints and connections using CSV files

Enhanced ID Manager (PSO only)

•	 Export to module ID CSV includes module hierarchy information

•	 Automated module definition update and re-creation through import of module ID CSV



Abaqus Solver Interface 12.0.110 Release
Abaqus Model Checker

Degenerated Hex Element
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Abaqus Model Checker

•	 Tool to identity modeling errors/warning. This is added as complimentary for the current element 
quality check.

•	 Currently implemented 6 errors, 19 warnings and 6 model information checks. This tool allows you 
to manually or automatically fix errors or warnings.

•	 Completely customizable environment. User-specific checks can be added easily.



Degenerated Hex Element

•	 Degenerated brick elements are either Hex8 or Hex20 elements, collapsed into a wedge element 
(Penta6 or Pet15).

•	 Standard node order for a 1st order, Hex8 (C3D8) element will be 1, 2, 3, 4, 5, 6, 7, 8. In cases of 
Degenerated Brick elements, the node order will be 1, 2, 3, 3, 5, 6, 7, 7, with nodes 4 and 4 being 
repeated during export.



FiberSim Support

•	 A Fibersim data reader enables users to read results of a draping simulation

•	 Fibersim data can be used in a new process to automatically transfer geometric composites 
information to finite elements for huge time savings in modeling time

•	 The ply information from FiberSim can be realized and assigned to the mesh created in HyperMesh

•	 More options are added to SHELLSECTION_COMPOSITE property to support the data from FiberSim

•	 The table entity will be used to assign the drape data to the element

Table Entity

A new entity is added to support *DISTRIBUTION support. The table entity can be created from the 
Solver Browser. The table is assigned to elements through property. Element will fetch data from the 
table that is assigned to the property. Three card images are added to the table entity.

•	 DISTRIBUTION_Thickness

–– Define the element thickness

•	 DISTRIBUTION_Offset

–– Define the element offset

•	 DISTRIBUTION_Drape

–– Define thickness and ply angle



The element value can be edit from the Edit Table dialog. 3D visualization the assigned property 
is enabled. 3D visualization is added to entity which also user to visualizes and check the element 
thickness.

Abaqus ID Project

•	 Each entity in HM as an ID, in case of Abaqus Interface the solver deck exported from HM will not 
retain those ID’s

•	 OEMs are working with strict ID ranges, E.g. Engine-system always has Part ID 2000000-2100000 
across all carlines. So an engineer always knows that he has to isolate PIDs 2000000-2100000 if 
he wants to examine the Engine-system. This is essential in pre- and post-processing.

•	 Example for a surface entity with ID’s in solver deck (HM group):

–– *SURFACE, NAME = <Prefix><ID>;<name_of_surface>

•	 Example for a surface entity without ID’s in solver deck (HM group):

–– *SURFACE, NAME = <name_of_surface>

Contact Manager

•	 Added sorting functionality

•	 Review contacts based on the color selected for that surface

Bars Panel

•	 The offset and section axis defined in the Beam section property will be used for beam creation.

•	 Either a property should be assigned to the component or during the beam creation the property 
must be selected.



Abaqus ODB Reader Support- HyperView

•	 Abaqus 6.12-1 reader has been added to the already existing 6.11-1, 6.10-EF and 6.10-1 readers.

•	 The HyperView Results Browser will reflect the assembly structure when reading an Abaqus .odb 
file with *Part and *Instance

General Enhancements

•	 Support for create, import and export membrane element M3D4 elements in Abaqus Explicit-
Template 

•	 Traction type is added to the material definition

•	 Elements option is linked to the Table. For each shell element thickness is calculated

Resolved Issues

•	 The Preview Unused system option in the Delete panel is fixed to capture systems used in 
*transform option

•	 The Tracking thickness option in *surface interaction can be exported/imported

•	 CONTACT THICKNESS REDUCTION=NOPERIMSELF option in * CONTACT CONTROLS ASSIGNMENT 
can be exported/imported

•	 The constraint name of the coupling will be preserved during import and export of Abaqus input 
decks

•	 Changing the order of a beam from linear to quadratic and again back linear, will no more change 
the element type to unsupported.

12.0 Release Notes

Abaqus 6.12 Reader

The Abaqus 6.12 reader has been added for Windows 32/64bit and Linux 64bit. HyperWorks 12.0 also 
supports these versions: 6.10, 6.10-EF, 6.11.

Results on Element Faces

A new reader option called Support element face results has been added to the ODB reader 
options. If set to true, for each *SURFACE definition a new component will be created. The component 
name matches the name of the surface definition. Post-processing of results which are available on 
element faces is only possible this way. The new option is also helpful for post-processing of contact 
results, as surfaces can be shown isolated from the rest of the model.

Random Response Analysis Enhancements

For random response analysis, the power spectral densities (PSD) and root mean square (RMS) of 
von Mises stresses are calculated based on a publication of Daniel J. Segalman, et al. (1998). The 
calculation time can be high for big models. In this case, results can be extracted in batch mode using 
HVTrans.



ANSYS Solver Interface 12.0.110 Release
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ANSYS v14.5 Version Support in HyperMesh and HyperView

ANSYS solver input deck format and result file format have been changed in its latest version: ANSYSv 
14.5. HyperMesh 12.0-110 supports this new format. Input decks from ANSYS 14.5 can be read in 
HyperMesh now.

ANSYS changed its result file format too. These result files can now be post processed in HyperView 
12.0-110.

Ply and Laminate Support for ANSYS Models in HyperMesh

In HyperMesh 12.0-110, ply and laminate entities are supported for ANSYS models. User can create 
composite models based on ply and laminate definitions. Also ply and laminate data can be imported 
from FiberSim files. On realization of the ply and laminate data, ply based model will be converted to 
zone based composite model. ANSYS composite properties and shell sections will be created. Also by 
defining composites by ply and laminates, visualization of plies is also supported.

Pretension Bolt Utility

In HyperMesh for ANSYS profile a new utility –“Pretension Bolt” is now available under the Tools menu. 
This tool can be used to create pretension loads in bolts, and can be used for both 1D bolts and 3D 
bolts simulations. You can create ANSYS Pretension elements –PRETS179, Pretension sections and 
pretension loads. User can pick multiple bolts to load in single operation. 



Other Enhancements

•	 New Element Support: Radiation elements SURF251 and SURF252 are now supported in 
HyperMesh.

•	 Radiation load support: Radiation load- RDSF in surface load (SFE) card is now supported in 
HyperMesh. This load can be applied using the Pressure panel.

•	 /TITLE card is now available under each load step. This can be used to name each load step. Load 
card OMEGA is also available for each load step.

•	 New cards support: Radiation cards – RADOPT, STEF, HEMIOPT, SPCTEMP.

•	 OptiStruct/Nastran to ANSYS conversion tool improvements – Conversion of MATT1, MAT1, 
conversion of CBUSH, CELAS, CGAP and conversion of PBUSH, PELAS, PGAP have been added in 
this release.

•	 Postprocessing of composite results – HyperView now post processes results for ‘all layers’ of 
composite elements defined by shell section option. Please note that this feature is not available for 
the result files created from ANSYS12 or earlier versions.

•	 New results support: Failure criteria results based on stresses in damaged material for composites 
are now supported. Following failure criteria results are now available - Maximum of all failure 
criteria(MAX), fiber tensile failure (FT), fiber compressive failure (FC), matrix tensile failure (MT) 
and matrix compressive (MC).

•	 ETABLE results support: Following elements are now added under ETABLE results - Fluid116,  
Link31, Link32, Link33, Link34, Mass71, contact170,  Contact 173, Solid70, Solid226, Solid227, 
Solid87, Solid90, Solid185-187, Plane55, Plane13, , Plane223, Plane35, Plane77, Plane182, 
Plane183, Shell281, SURF151, SURF152, SURF251, SURF252 

Resolved Issues

•	 Issue with Auto contact where in few cases contact surfaces were not recognized has been fixed.

•	 Issues with mass calculations of MASS21 element type have been fixed.

•	 Issue with more than one SECJOINT card where HyperMesh used to import only the first card has 
been fixed. Now HyperMesh can import more than one SECJOINT cards.

•	 Issue with beam elements where pin flag value is set to 3 even though no value has been assigned 
has been fixed.

•	 Issue with Load case label mismatch in HyperView in Linux platform has been fixed.

12.0 Release Notes

Bar Panel Updates

Bar panel in 1-D page has been now customized for ANSYS profile. Options to create bar elements 
such as “component”, “vector” are not applicable for ANSYS solver and hence have been removed. 
Within ‘Plane’ and ‘Node’, only options relevant to ANSYS are retained. This helps user to pick the right 
option to create bar elements in HyperMesh.

Supported Versions

HyperMesh-Ansys interface is now updated to ANSYS14.0 release.



HyperView Interfacing New Features

•	 HV now supports ANSYS14.0 result files

•	 ETABLE results are now available for the following thermal elements:

–– SOLID70, SOLID87, SOLID90 and SURF152

•	 HV now supports ANSYS INFIN9 and INFIN110 element types

Resolved Issues

HyperMesh interface resolved issues:

•	 Issue with the export of load collectors by “displayed” option where all displayed collectors were 
not exported has been fixed
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General

•	 Parasolid  Native CAD import is added 

ACIS

•	 Version R21 is added

Catia

•	 Version R10 to R22 is enabled

DXF

•	 AutoCAD 12 is added



IGES

•	 6.0; JAMA-IS is available

JT

•	 9.5 support is available for import and export

Parasolid

•	 V20 support is added for non-native import

•	 V25 support is available in native reader

ProE

•	 Version 13 and CREO 2 support is added

SolidWorks

•	 Version 2012 is supported

STEP

•	 AP203/AP214 is supported

UG

•	 Up to UG NX 8.0 is supported using non-native interface

•	 Up to UG NX 8.5 is supported using native interface depending on UG-NX installation (MAC is not 
supported)

VDAFS

•	 V2 is supported

12.0 Release Notes

General

New Features/Enhancements

•	 Added @CreateMissingSurfaceContours option to generate contour of surface that failed 
importing due to cleanup issues

•	 CAD reader INI files are also looked for in HW_CONFIG_PATH defined directories

•	 Import of CAD axis systems as HyperMesh entities

•	 Improved error message when trying to import a CAD file with the wrong format 



ACIS

New Features/Enhancements

•	 ACIS R21 support

Resolved issues

•	 Fix missing surfaces at import for specific models

Resolved issues

•	 Removed incorrect error message about missing license file in license server log

•	 Enhanced import cleanup algorithm when very small surfaces are present in the model

Catia

New Features/Enhancements

•	 CATIA V5-6R2012 support

•	 Added support for entity names in non-Latin alphabets

Resolved issues

•	 Improved import quality

•	 Fix surface normal orientation when importing CATIA files

•	 Fixed edge stitching issue when importing specific CATIA file

DXF

Resolved issues

•	 Fixed crash when importing specific files

IGES

New Features/Enhancements

•	 Surfaces get names at IGES export

•	 New @SkipConnectivityComputation allows quick IGEs import without connectivity information 
for review purposes

 

Resolved issues

•	 Fixed missing surfaces when importing specific files

•	 Fixed incorrect edges when importing specific IGES files

•	 Fixed HM hanging when importing specific files

•	 Fixed inconsistent surface normals at import time with specific models



JT

New features/Enhancements

•	 Added more details about JT assemblies import to jt_reader.msg file

Resolved issues

•	 Improved import quality and time

•	 Improved assembly reading time

•	 Fixed issue with importing spherical surfaces

•	 Fixed HyperMesh not responding when importing specific JT files

•	 Fixed bug preventing to import JT file after UG file has been imported

•	 Fixed issue with parts not being positioned correctly in specific assembly

Parasolid

New Features/Enhancements

•	 Added support for entity names in non-Latin alphabets

Resolved issues

•	 Fixed model specific import issues

•	 Fixed HyperMesh not responding when importing specific Parasolid files

•	 Fixed issues with component names on Linux

•	 Fixed issue with surface being split into many surfaces at export

•	 Fixed import issues with small scale models

•	 Fixed issues with surfaces projecting out at import time

•	 Fixed being unable to export STEP file to root directory on Windows platform

ProE

New Features/Enhancements

•	 Added support for entity names in non-Latin alphabets

 

Resolved Issues

•	 Fixed import issues for specific models

•	 Fixed import issues with assemblies located in root directories on Windows

•	 Fixed incorrect metadata at import



SolidWorks

New Features/Enhancements

•	 SolidWorks 2012 support

•	 Added support for entity names in non-Latin alphabets

Resolved issues

•	 Fixed issue with incorrect component names on Linux

•	 Fixed issues with importing assemblies on Linux

STEP

New Features/Enhancements

•	 Added support for entity names in non-Latin alphabets

Resolved issues

•	 Fixed issue with solids lost at import

•	 Fixed issue with metadata lost at import

•	 Fixed reading of composite curves

•	 Fixed being unable to export STEP file to root directory on Windows platform

UG

New Features/Enhancements

•	 UG NX 8.0 support is now available on all supported platforms

•	 Import of UG/NX files without requiring NX being installed

Resolved Issues

•	 Fixed issue with UG weld data

•	 Fixed HM hanging when importing specific model

•	 Fixed issues with missing surfaces at import

VDAFS

Resolved Issues

•	 Fixed HM hanging when importing specific model



LS-DYNA Solver Interface 12.0.110 Release

This release supports versions LS-DYNA 970, 971

Highlights of the

Contents

Support of *PARAMETER and *PARAMETER_EXPRESSION

New Keywords Supported

Update to Supported Keywords Based on LSDYNA 971 R 6.1.0

Reorganization

Conversion

Unsupported Keyword

Import Solver Options

Export Solver Options

HyperGraph New Feature

Resolved Issues

12.0 Release Notes

12.0.110 Release Notes

Support of *PARAMETER and *PARAMETER_EXPRESSION

•	 *PARAMETER and *PARAMETER_EXPRESSION support is limited to Input/output only for the 
keyword mapped to all the HM entities except elements.

•	 Parameterization of entity ID’s not supported

•	 Unsupported parameterized entities are replaced with corresponding values during import to avoid 
loss of data.

•	 The variables parameterized will be grayed out in the card editor so that it can’t be changed.

•	 In Macros and Browser if any parameterized variable is changed a warning message appears in the 
message bar and the value will not be changed.



New Keywords Supported

•	 *DEFINE_FRICTION

•	 *DEFINE_CURVE_FUNCTION

•	 *CONTROL_MPP_IO_LSTC_REDUCE

•	 MAT111 - *MAT_JOHNSON_HOLMQUIST_CONCRETE

•	 MAT141 - *MAT_RATE_SENSITIVE_POLYMER

•	 MAT162 - *MAT_COMPOSITE_MSC_OPTION

•	 MAT168 - *MAT_POLYMER

•	 MAT244 - *MAT_UHS_STEEL

•	 *ALE_FSI_PROJECTION

•	 *INITIAL_ALE_MAPPING

•	 *CONTROL_MPP_DECOMPOSITION_OUTDECOMP

•	 *CONTROL_MPP_DECOMPOSTION_RCBLOG

•	 *DATABASE_OPTION_DISBOUT

•	 *DEFINE_CONNECTION_PROPERTIES_ADD

Update to Supported Keywords Based on LSDYNA 971 R 6.1.0

•	 *AIRBAG_HYBRID_JETTING

•	 *MAT_34 - *MAT_FABRIC

•	 *MAT_100 - *MAT_SPOTWELD

•	 *MAT_120 - *MAT_GURSON

•	 *MAT_120_JC - *MAT_GURSON_JC

•	 *MAT_169 - *MAT_ARUP_ADHESIVE

•	 *MAT_ADD_EROSION

•	 *CONTROL_SHELL

•	 *CONTROL_RIGID

•	 *CONTACT_ENTITY

•	 *CONSTRAINED_RIGID_BODIES

•	 *DAMPING_PART_STIFFNESS_SET

•	 *DATABASE_BINARY_FSIFOR

•	 *DATABASE_OPTIONS

•	 *PART_COMPOSITE

•	 *PART_COMPOSITE_TSHELL



Reorganization

•	 Keywords *BOUNDARY_PRESCRIBED_MOTION_SET, *BOUNDARY_PRESCRIBED_MOTION_RIGID 
are moved from load collectors to Loads (constraints, velocity and acceleration).

•	 Keywords *ALE_MULTIMATERIAL_GROUP and *SET_MULTI_MATERIAL_GROUP are moved from 
Interfaces to Sets.

Conversion

•	 LS-DYNA to RADIOSS conversion using HyperCrash feature introduced with extended coverage for 
conversion.

Unsupported Keyword

•	 Import reader updated to efficiently detect unsupported keywords and move to HMX file.

Import Solver Options

•	 Option to name *CONSTRAINED_EXTRA_NODES_NODE and *CONSTRAINED_EXTRA_NODES_
NODE with PID_NSID

Export Solver Options

•	 Option to remove “.##” added for duplicate names during import from getting exported to the 
solver deck.

HyperGraph New Feature

•	 Support of NODOUTHF and ELOUTHF subcases in binout file

Resolved Issues

HyperMesh

•	 Support assembly names with “,”  and maximum of 100 characters during reading solver decks

•	 Set created from Mass panel is assigned correct card image based on selected entity type

•	 Reading of keywords *CONSTRAINED_LINEAR_GLOBAL and *CONSTRAINED_LINEAR_LOCAL 
from  solver decks

•	 Fail to import solver decks with unsupported keywords

•	 Loss of data during import of following keywords fixed

–– *AIRBAG_INTERACTION

–– *CONTACT_ERODING_SINGLE_SURFACE_ID

–– *INTIAL_GAS_MIX

–– MAT_32 - *MAT_LAMINATED_GLASS

–– MAT_126 - *MAT_MODIFIED_HONEYCOMB

–– MAT_100 -*MAT_SPOTWELD_DAIMLERCHRYSLER

–– MAT_059 (*MAT_COMPOSITE_FAILURE_{OPTION}_MODEL)



•	 Extra optional card exported for all *CONTACT keywords as blank lines fixed

•	 Import reader updated to handle both UPPERCASE and LOWERCASE strings in the keywords

•	 Missing directional node for beam elements while exporting in different includes fixed

•	 Import reader updated to import multiple *LOAD_BODY keywords in the deck

•	 Name of set referred in Group HM entity lost during export is fixed

•	 3D Visualization for shell elements of card image *ELEMENT_SHELL_COMPOSITE

•	 Disable transformation defined in the model before exporting an include file from include 
browser

•	 Export an include options sets the default path as include file’s original directory where it was 
imported from rather than the start directory

 

HyperView

•	 Error in strain contour of solid elements

•	 Incorrect %thinning reduction value of -1.#IOE+00

•	 Error in displacement at first time step

•	 Name of the components in the Component Browser not as per the input deck

HyperGraph

•	 Fixed difference in request label between windows and Linux for rbdout file

•	 Ability to read and plot based upon node groups from a LS-Dyna nodfor file

•	 Fixed crashes in binout and jntforc reader

12.0 Release Notes

Support of *PARAMETER and *PARAMETER_EXPRESSION

•	 *PARAMETER and *PARAMETER_EXPRESSION support is limited to Input/output only for the 
keyword mapped to the following HM entities: components, materials, properties, curves, loads, 
load collectors, system collectors, and control volumes.

•	 Parameterization of entity IDs not supported

•	 Unsupported parametrized entities are replaced with corresponding values during import to avoid 
loss of data.

•	 The variables parametrized will be grayed out in the card editor so that it can’t be changed.

•	 In macros and browsers, if any parameterized variable is changed a warning message appears in 
the message bar and the value will not be changed.

Performance and Speed Improvements

•	 Performance/speed  improvement in Nastran to LS-DYNA conversion

•	 Performance/speed improvement in import/export of large models



Solver Browser

Show/Hide/Isolate functionalities for Include files in the Solver Browser are now available.

Maximum Number of Characters

Maximum number characters for names of components, materials, and properties extended to 80 in 
import and export.

Keyword Updates

Updates to the following keywords:

•	 *MAT_ENCHANCED_COMPOSITE_DAMAGE_TITLE

•	 *CONTROL_SPOTWELD_BEAM

•	 *CONSTRAINED_EXTRA_NODES_NODE/SET

•	 *CONTROL_IMPLICT_FORMING

•	 *INITIAL_VELOCITY_RIGID_BODY

•	 *MAT_FU_CHANG

•	 *MAT_LOW_DENSITY_SYNTHETIC_FOAM

•	 *CONTROL_CONTACT

New HyperView Interfacing Features

•	 Support of d3int files

•	 FEMZIP reader updated to FEMZIP libraries v 6.0

•	 New FEMZIP reader options added

–– Effective strain with prestrain removed – Removes the effective strain value at time 0 from all 
the time steps.

–– Strain Tensor with prestrain removed – Removes the strain tensor value for all its components 
at time 0 from all the time steps.

•	 Effective plastic strain at mid layer added for shell elements if it is missing in the file.

Resolved Issues

The following HyperMesh interfacing issues have been resolved:

•	 Component Table and Model Browser synced to reflect the changes in thickness and mass

•	 Issue with reading *BOUNDARY_SPC_NODE_ID is fixed.

•	 Export of *INCLUDE_STAMPED_PART and *INCLUDE_STAMPED_PART_SET at the end of the 
deck.

•	 Issues with reading *DEFINE_TABLE is fixed.

•	 Issue with reading Nastran file into LS-DYNA user profile fixed

•	 Reading issue with *CONTACT when either slave or master not defined is fixed.



•	 Reader improved to handle decks with multiple *INCLUDE_STAMPED_PART and *INCLUDE_
STAMPED_PART_SET

•	 Improved reading of *MAT_TRANSVERSELY_ANISOTROPIC_ELASTIC_PLASTIC_ECHANGE

•	 Issue with export of *CONTACT_RIGID_SURFACE addressed.

The following HyperView interfacing issues have been resolved:

•	 Model reader fixed to handle input decks with *INCLUDE_STAMPED_PART, *INCLUDE_
STAMPED_PART_SET, and *INCLUDE_TRANSFORM

•	 Crash of HyperView when animating with contour on result files with airbag particles fixed



Nastran Solver Interface 12.0.110 Release
1D Element Forces Vector Plots

Model Checker

Highlights of the

Contents
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Resolved Issues

12.0  Release Notes

12.0.110 Release Notes

1D Element Forces Vector Plots

Vector and tensor plots for 1D and 2D forces and moments, respectively, are now available in 
HyperView for Nastran .op2 and .xdb result file formats.

To visualize the 1D element forces vector plots in HyperView, it is required to load the Nastran input 
deck as model file and .op2 or .xdb as result file, and choose the Advanced Result-Math template.

Model Checker

Several new checks added to the Nastran Model Checker, available via Tools > Model Checker > 
Nastran.

New Error checks:

•	 Property with zero cross section area.

•	 Component with mixed solid and shell elements.



•	 RBE2 with constrained dependent nodes.

•	 Zero-length CBUSH without CID.

•	 MPC with free independent nodes.

New Warning checks:

•	 Material Rho is not defined.

•	 Material Nu is zero.

•	 PCOMP thickness is not defined.

•	 1D Prop beamsection mismatch.

•	 CONM1 with zero diagonal mass matrix values.

•	 CONM2 with zero mass.

•	 Orientation vector along axis vector.

New Import Solver Option: Organize Unidentified Systems into Separate Collectors

This option affects how systems without HyperMesh comment cards are organized into System 
Collectors during import.

When this option is OFF (default), HyperMesh will create a single System Collector containing all 
systems without HyperMesh comments.

When this option is ON, HyperMesh will instead create a separate System Collector for each system 
without HyperMesh comments.

Nodal Thickness

3D visualization of elements with nodal thickness is now possible in HyperMesh using the 3D Element 
Representation visualization mode.

Mass calculation and summary templates now consider element nodal thicknesses as well.

Resolved Issues

•	 SET1 bulk data element set interpreted as node set issue has been resolved. If the solver deck 
does not contain HM comments identifying the set type, HM will create both element and node set 
(same behavior as case control SET).

•	 Model Checker resolved issues:

–– RBE3 with independent node connected only to other RBE3 not being flagged issue has been 
resolved.



–– RBE2, RBE3 free independent nodes auto correct not deleting free arms issue has been 
resolved.

–– Property is missing material error flagging composite elements even when material is correctly 
assigned issue has been resolved.

•	 Improved Moment of Inertia calculation for CONM2 elements with Inertia and Offset values.

•	 PBARL dim values not exporting correctly in long format issue has been resolved.

•	 Import of certain include files creating additional components named MISC_x issue has been 
resolved.

•	 HyperGraph not reading .pch files including AUTOSPCs entries issue has been resolved.

•	 HyperGraph not reading .pch files containing ERP results together with other result types issue has 
been resolved.

•	 HyperGraph not reading .op2 files without subcase identifier issue has been corrected.

•	 HyperView .op2 reader assigning ROD (61) config to BAR, BEAM and BEND elements issue has 
been resolved. Now these elements are assigned BAR (60) config.

12.0 Release Notes

New Export Solver Option: Auto-adjust RBE3 0.0 weight factor

When turned ON, HyperMesh will change any 0.0 weight factors on RBE3 elements to the specified 
small value. This adjustment is done in the exported solver deck only, and not in the HyperMesh 
model. This option is OFF by default.

Nastran Model Checker

Additional checks have been added to the Nastran Model Checker.

New OP2 Reader Option: Deformed Shape: Allow all nodal vector result types

When switched to YES, this option allows all available nodal vector result types in the OP2 file to be 
used in the Deformed Shape panel. When switched to NO (default), the Deformed Shape panel will 
automatically filter result type selection according to analysis type.



OP2 Format Results File

HyperView now supports importing of CONM2 elements from OP2 format results file

Resolved Issues

HyperMesh interfacing resolved issues:

•	 NSML1 mass incorrectly distributed amongst 2D elements and properties issue has been 
corrected. This fix includes corrections to mass calc panel and summary templates.

•	 Pressure direction miss-assignment when importing PLOAD cards from separate files into a 
current model has been corrected.

•	 DRESP2 cards containing a large number of DTABLE entries missing after export issue has been 
corrected.

•	 TABLEx export in Long Format missing second line (empty) issue has been fixed.

•	 Import error due to keyword alignment of INIPENE option inside BCTPARM has been fixed.

•	 TABLED missing when using Export > Displayed option issue has been fixed.

•	 A memory issues causing BSURFs to be omitted on import has been corrected.

•	 DAREA/DELAY/DPHASE on SPOINTS not importing properly issue has been fixed.

HyperView interfacing resolved issues:

•	 An issue when plotting SDISP in result files containing both DISP and SDISP results has been 
resolved.



PAM-CRASH Solver Interface 12.0.110 Release
•	 Supported Keywords Updated in PAM 2010 User Profile

•	 New Features - HyperView Interfacing

Highlights of the
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New Features - HyperView Interfacing

New Features - HyperGraph Interfacing

Resolved Issues

12.0 Release Notes

12.0.110 Release Notes

Supported Keywords Updated in PAM 2010 User Profile

•	 FRAME

•	 MAT 105

•	 UNIDIRECTIONAL COMPOSITE

•	 FABRIC COMPOSITE B-PHASE PLY MODEL

•	 MTJOIN

•	 OTMCO

•	 BDFORC

•	 FPMCONTROL

•	 ERFOUTPUT

•	 MASS

New Features - HyperView Interfacing

•	 Support of PAM 2012 results in ERHF5 files and DSY files

New Features - HyperGraph Interfacing

•	 Support of PAM 2012 results in ERHF5 files and THP files



Resolved Issues

HyperMesh

•	 Issue with import of ID ranges with extra blanks

•	 Issue with export of MAT 302

12.0 Release Notes

Supported Versions

Supported versions PAM 2G 2005 – PAM2G 2010

Supported Keywords Update - PAM 2009 User Profile

•	 CHAMBER

•	 CONLO

•	 ECTRL

•	 FRAME

•	 FUNCTION_SWITCH

•	 GROUP

•	 OCTRL

•	 MAT16, MAT214

•	 DELEM

Supported Keywords Update - PAM 2010 User Profile

•	 MAT105, MAT 130/131/132

•	 UNIDIRECTIONAL_COMPOSITE

•	 ERFOUTPUT

•	 CHAMBER

•	 MASS

•	 SHELL TIME STEP

Newly Supported Keywords - PAM 2010 User Profile

•	 FABRIC COMPOSITE B-PHASE PLY MODEL

•	 TETRA10

•	 BDFORC

•	 FPMCONTROL

•	 OTMCO



ID Pools

ID pools added for sensor entity. Keywords DELEM, FUNCTION_SWITCH, and SENSOR are placed in 3 
different ID pools to allow duplicate ID’s as per solver.

ID pools added for property entity in PAM user profile. Each keyword is now mapped to a separate ID 
pool.

New HyperView Interfacing Features

•	 Supported versions PAM 2G 2005 – PAM2G 2011

•	 Support of PAM 2011 results in ERHF5 files

Resolved Issues

•	 Issue  with export of MAT 143 fixed

•	 Issue with Rigid element creation and connectivity update when selecting sets with more than 
10000 nodes from Rigids panel fixed



PERMAS Solver Interface 12.0.110 Release
Element Summary

Laminate Modeling

Highlights of the

12.0.110 Release Notes

Element Summary

This new tool will summarizes the number and type of elements in the current HyperMesh model for a 
Permas analysis.

Laminate Modeling

Support for $PLY and $LAMINATE is added for modeling ply.



RADIOSS Block Interface 12.0.110 Release

This release supports versions RADIOSS 44, 51,90, 100, 110 and 120

Highlights of the

Contents
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Import

Reorganization

Resolved Issues

12.0 Release Notes

12.0.110 Release Notes

New User Profile

•	 Introduced RADIOSS 120 user profile

•	 Update the following keywords based on RADIOSS 120 user profile

–– /INTER/TYPE21, /INTER/TYPE7, /INTER/TYPE11, INTER/TYPE19, /INTER/TYPE2

–– /MAT/LAW78

–– /MAT/LAW19

–– /MAT/GAS

–– /MAT/LAW2

–– /MAT/LAW5

–– /PROP/SOLID

–– /PROP/SPR_CRUS

–– /PROP/TYPE17

–– /MONVOL/FVMBAG

–– /MONVOL/FVMBAG1

–– /FAIL/CONNECT

–– /IMPVEL



New Keyword Support

•	 INIBRI/EPSP

•	 INIBRI/AUX

•	 INIBRI/ENER

•	 /ANIM/NODA/TEMP

•	 /ANIM/NODA/DAMA2

•	 /ANIM/NODA/DENS

•	 /ANIM/NODA/P

–– /IMPDISP

–– /SKEW/FIX

–– /SPHGLO

–– /DAMP

Import

•	 Provision to import INIBRI cards added to the solver options in the Import Browser.

Reorganization

•	 Moved all the engine keywords from the engine file to the control cards in HyperMesh. The engine 
file GUI is removed from the Export and the Solver panel.

•	 Support of engine file export in batch

Resolved Issues

HyperMesh

•	 Extra line exported in /INJECT1 keyword.

•	 /MAT/LAW3, /MAT/LAW4, MAT/LAW49 converted to corresponding material and /EOS/
POLYNOMIAL.

•	 /FAIL/USER1 changes to FAIL/USER2 during import.

•	 Crash while exporting RADIOSS deck with includes

HyperView

•	 Error reading gzip result files

•	 Error in component name while reading result files

•	 Missing % thinning results when thermal results are in the result file

12.0 Release Notes

Supported Versions

Supported versions RADIOSS 44, 51,90, 100 and 110



New Keyword Support

•	 INISHE/INISH3 OTHRO

•	 INISHE/INISH3 OTHRO_LOC

•	 INISHE/INISH3 EPSP

•	 INISHE/INISH3 EPSP_F

•	 INISHE/INISH3 STRA_F

•	 INISHE/INISH3 STRS_F

•	 INISHE/INISH3 STRS_GLOBAL

•	 INISHE/INISH3 AUX

Import of these cards also made optional with a check box in the solver options of the import browser. 
If the cards are not chosen to import they will be pushed to .hmx file. The .hmx file will be saved in 
import file location and attached as an include file with skip option.

Resolved Issues

•	 /PROP/TYPE19 referred in /PROP/TYPE17 lost during import is fixed.

•	 Error in exporting all Includes from the Include browser is fixed

•	 Read names completely when it has character “\”

•	 Duplicate /BEGIN card with import and include option is fixed

•	 Issue with reading /INTER/TYPE21 is fixed

•	 Reader failure while reading /RLINK is fixed

•	 Issue with reading /INTER/TYPE11 as per RADIOSS 110 format

•	 Transformation manager error when applying /TRANSFORM/SCA is fixed

•	 Line 1 repetition in export of /MAT/LAW15 is fixed



OptiStruct Interface 12.0.110 Release
Auto Contact Tool

Pretension Manager

1D Element Forces Vector Plots
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12.0 Release Notes

12.0.110 Release Notes

Auto Contact Tool

The Auto Contact tool for OptiStruct allows you to quickly and easily create one or many contact 
interfaces at once between several parts of your model. The Auto Contact Browser organizes all 
interfaces found by the Auto Contact search, where you can review and modify them before accepting 
any changes.

This tool is accessible in HyperMesh 12.0.110 via any of the following locations:

•	 Tools menu > Auto-Contact

•	 BCs menu > Create > Auto-Contact

•	 Utility Menu > FEA > Tools: Auto-Contact



Pretension Manager

The Pretension Manager tool allows to create and edit 1D and 3D pretension bolt loads and sections for 
OptiStruct in a quick and streamlined fashion.

This tool is accessible in HyperMesh 12.0.110 via any of the following locations:

•	 Tools menu > Pretension Manager

•	 Utility Menu > FEA > Tools: Pretension Manager

Pretension cards supported for OptiStruct:

•	 PRETENS: New entity set type

•	 PTFORCE: New flux load type

•	 PTADJST: New flux load type

•	 PTADD: New Load Collector

•	 PRETENSION: New subcase information entry

•	 STATSUB(PRETENS): New subcase information entry

1D Element Forces Vector Plots

Vector and tensor plots for 1D and 2D forces and moments, respectively, are now available in 
HyperView for OptiStruct .op2 and .h3d result file formats.

To visualize the 1D element forces vector plots in HyperView, it is required to load the .fem input deck 
as model file and .op2 or .h3d as result file, and choose the Advanced Result-Math template.



Abaqus to OptiStruct Solver Conversion Enhancements

New enhancements to convert non-linear analysis data, including:

•	 Gasket elements, properties, materials, loading curves

•	 Elasto-plastic material curves and properties

•	 Temperature dependent material data

•	 Pretension loads and sections

Model Checker

Several new checks added to the OptiStruct Model Checker, available via Tools à Model Checker à 
OptiStruct.

New Error checks:

•	 Property with zero cross section area

•	 Component with mixed solid and shell elements

•	 RBE2 with constrained dependent nodes

•	 Zero-length CBUSH without CID

•	 MPC with free independent nodes

New Warning checks:

•	 Material Rho is not defined

•	 Material Nu is zero

•	 PCOMP thickness is not defined

•	 1D Prop beamsection mismatch

•	 CONM1 with zero diagonal mass matrix values

•	 CONM2 with zero mass

•	 Orientation vector along axis vector

ERP Optimization and Radiated Sound Support

Support for OptiStruct ERP analysis, optimization, and Radiated Sound cards:

•	 PANELG: New entity set type.

•	 ERPPNL (12.0): Entity set type.

•	 FRERP: New response type. Added to optimization responses and Dscreen panels.

•	 RADSND (bulk data card): New entity set.

•	 RADSND (subcase information entry): New subcase and Global Case Control entries added.

•	 SINTENS: New subcase and Global Output Request added.

•	 SPOWER: New subcase and Global Output Request added.

•	 SPL: New subcase and Global Output Request added.



•	 Related PARAMs (12.0):

–– ERPC

–– ERPRLF

–– ERPRHO

–– ERPREFDB

–– RHOCP

Nodal Thickness

3D visualization of elements with nodal thickness is now possible in HyperMesh using the 3D Element 
Representation visualization mode.

Mass calculation and summary templates now consider element nodal thicknesses as well.

New Import Solver Option: Organize Unidentified Systems into Separate Collectors

This option affects how systems without HyperMesh comment cards are organized into System 
Collectors during import.

•	 When this option is OFF (default), HyperMesh will create a single System Collector containing all 
systems without HyperMesh comments.

•	 When this option is ON, HyperMesh will instead create a separate System Collector for each 
system without HyperMesh comments.

OptiStruct User Profile Fully Replaces RADIOSS (Bulk Data) User Profile

The RADIOSS (Bulk Data) User Profile in HyperMesh has been removed, and is fully replaced by the 
OptiStruct User Profile. The OptiStruct User Profile can be used to define analysis and optimization 
solution sequences seamlessly for the OptiStruct solver.

Additional Solver Card Support Updates

•	 CMSMETH: DMIGDV continuation line added.

•	 CDSMETH: New Load Collector.

•	 Output Request updates:

–– MODAL argument added to STRESS, ELFORCE.

–– RTYPE argument added to PFMODE.

–– PSDF RANDOM option added to ELFORCE, DISPLACEMENT, VELOCITY, ACCELERATION



•	 SET: SET_RIGID added as new entity set type for creating SET with Type=RIGID.

•	 HYBDAMP cards:

–– New Load Collector (bulk data card).

–– New Global Case Control entry (I/O option).

•	 CONTACT updates:

–– New ADJUST option added

–– New Static Friction Coefficient Property Option to define MU1 field.

•	 PCONT updates:

–– FRICESL option added

–– CLEARANCE option added.

•	 TIE: New ADJUST option added.

•	 CONTPRM: FRICESL option added.

•	 PGAP: FRICESL option added.

•	 PARAM updates:

–– CONTFEL

–– FASTFR

–– INTRFACE

–– EXPERTNL,CNTSTB

•	 CONTPRM: MTET10 option added.

•	 GAPPRM: GAPOFFS option added.

•	 DRESP3: New external response type added to optimization responses panel.

•	 DOBJREF: LOWFQ/HIGHFQ fields added.

•	 PCNTX5, PCNTX7, PCNTX20: New extension cards added to PCONT.

•	 CFAST: New mass and rod element types.

•	 PFAST: New property.

•	 Loadsteps updates:

–– New Heat Transfer subcase type Heat Transfer (transient). The previously existing heat transfer 
subcase type is now renamed to Heat Transfer (steady state) for consistency.

–– STATSUB(STRUCTURE): New subcase information entry for to heat transfer subcases. 

Resolved Issues

•	 Ansys > OptiStruct solver conversion resolved issues:

–– Conversion error with BEAM4 containing ADDMAS option has been corrected.

–– PIPE16 now converts to PBEAML with correct dimensions, instead of PBEAM.

–– PCONT converted from CONTA173/174/175 now assigns GPAD=0.0 when KEYOP(11)=0, and 
GPAD=THICK when KEYOP(11)=1. If KEYOP(12)=5, it converts to CONTACT with Type=FREEZE.

–– CONTA175 conversion is now supported.



–– Conversion of plastic material definitions including MPDATA/TB is now supported.

–– ACEL converting to GRAV without reversing signs issue is resolved.

•	 CNTNLSUB option missing from Loadstep Browser issue has been resolved.

•	 Model Checker resolved issues:

–– RBE3 with independent node connected only to other RBE3 not being flagged issue has been 
resolved.

–– RBE2, RBE3 free independent nodes auto correct not deleting free arms issue has been 
resolved.

–– Property is missing material error flagging composite elements even when material is correctly 
assigned issue has been resolved.

•	 Improved Moment of Inertia calculation for CONM2 elements with Inertia and Offset values.

•	 PFMODE not allowing selection of some GRIDC sets issue has been resolved.

•	 FE-Overwrite enhancements for Plies, Laminates and Tables.

•	 Updated subcase entry rules and default paramenter values in Loadstep browser.

•	 PBARL dim values not exporting correctly in long format issue has been resolved.

•	 Import of certain include files creating additional components named MISC_x issue has been 
resolved.

•	 Loadstep panel not allowing to deselect STATSUB(PRELOAD) from a subcase issue has been 
corrected.

•	 HyperGraph not reading .pch files containing ERP results together with other result types issue has 
been resolved.

•	 HyperGraph not reading .op2 files without subcase identifier issue has been corrected.

12.0 Release Notes

New Export Solver Option: Auto-adjust RBE3 0.0 weight factor

When turned ON, HyperMesh will change any 0.0 weight factors on RBE3 elements to the specified 
small value. This adjustment is done in the exported solver deck only, and not in the HyperMesh 
model. This option is OFF by default.

Gasket Elements Support

Added support for the new RADIOSS (Bulk) gasket elements:



•	 CGASK6, CGASK8: New element types.

•	 MGASK: New material.

•	 PGASK: New property.

•	 Solid element normal review and editing now available for gasket elements.

–– Element normal direction review / reverse available via the Tool > Normals panel.

–– Advanced 3D normal direction control available via the 2D > Composites > Element Normals 
panel

Solver Cards Supported Updates

•	 ASSIGN: STARTER and ENGINE options added.

•	 SOLVTYP: New AUTO option added.

•	 PFMODE, PFPANEL, PFGRID: Now available as both global and subcase-specific entries.

•	 CONTPRM: New IGNORE option added.

•	 MATX42: Removed obsolete ISTR option.

•	 MAT4: New CP field added.

•	 MAT5: New CP field added.

•	 PGAPHT: New extension card inside PGAP

•	 ERP: New Output Request.

•	 ERPPNL: New entity set type

•	 DOPTPRM: New REMESH and OPTMETH options added

•	 PARAM updates:

–– ERPC

–– ERPRLF

–– ERPRHO

–– ERPREFDB

–– RHOCP

–– AMSESLM

–– LFREQ

–– GE_MOD

–– DUPTOL

New OP2 Reader Option: Deformed Shape: Allow all nodal vector result types

When switched to YES, this option allows all available nodal vector result types in the OP2 file to be 
used in the Deformed Shape panel. When switched to NO (default), the Deformed Shape panel will 
automatically filter result type selection according to analysis type.



OP2 Format Results File

HyperView now supports importing of CONM2 elements from OP2 format results file.

Resolved Issues

HyperMesh interfacing resolved issues:

•	 NSML1 mass incorrectly distributed amongst 2D elements and properties issue has been 
corrected. This fix includes corrections to mass calc panel and summary templates.

•	 Pressure direction miss-assignment when importing PLOAD cards from separate files into a 
current model has been corrected.

•	 DRESP2 cards containing a large number of DTABLE entries missing after export issue has been 
corrected.

•	 TABLEx export in Long Format missing second line (empty) issue has been fixed.

•	 SID of setdof inside PFMODE with type=STRUCTURE now requires SET of type=GRIDC only.

•	 ACMODL 2nd line missing when it only contains MAXSGRID parameter issue has been fixed.

•	 PCOMPP export in Long Format with miss-aligned Z0 issue has been fixed.

•	 TABLED missing when using Export > Displayed option issue has been fixed.

•	 DAREA/DPHASE on SPOINTS not importing properly has been fixed.

•	 PEAKOUT option exporting as PEAK inside several output requests issue has been fixed.

HyperView interfacing resolved issues:

•	 An issue when plotting SDISP in results files containing both DISP and SDISP results has been 
resolved.
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Spring Element

The spring element BUSH is now supported. To create this element, you can use Mesh > Create > 1D 
Elements > Spring. The macro command created will be .MCE BUSH.

To create the associated property, you can use Property > Create. The property created will be .MCC 
BUSH. 

Conversion Tool:  Samcef to Optistruct

Convertion tool Samcef to Optistruct has been added in the menu bar Tool > Convert. The following 
entities are converted:

•	 Nodes

•	 Elements

•	 Material (isotropic and orthotropic)

•	 Properties

•	 Loadsteps

Known limitations: For the moment, there is no graphic interface to show you which parameters are 
converted but you have a log file to help you after the conversion.



Visualization of the Layers in 3D Elements

Visualization of the composite plies on the 3D element is now available via the icon Composite Layers.

12.0 Release Notes

Parameter NEXCE

Support the offset value in the shell and beam properties through the parameter NEXCE.
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